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Introduction

This course has been made for the scaffolding package of SCIA Engineer. In this package the following

modules are included:

Module (sen)

Description

sen.00

1D member modeller

Productivity toolbox

Linear statics 2D

Linear statics 3D

Bridge Combinations & Design EN

Surface load generators

sen.01

Planar 2D members

Curved 2D members

Cut-outs of 2D members

sens.00

Tension only members

Pressure only support of soil

Nonlinear springs, gaps

Geometrical nonlinear of frames

Geometrical NL analysis of surfaces

sens.01

Stability analysis of frames

Stability analysis of surfaces

sens.02

Plastic analysis of steel structures

Pressure only on surfaces

Plastic analysis for surface members

Friction springs

sens.03

Advanced cable analysis

Nonlinear stability analysis

Membrane elements

Nonlinear soil interaction

sensd.0l.en

Steel code check — EN 1993-1-1

sensd.06.en

Scaffolding checks - EN 12811-1

sendt.01

General arrangement drawings

Below you can find an image of the workspace of SCIA Engineer and where to find the different components.
@ sciaen,

DB A wm&@ © o 2
Main menu SCIA Spotlight Status bar |E
I PROJECT DATA (1) ¥
Licence name
Licence number
Properhes gt
Tl panel | "I
No. of nodes
E“_ No of beams
‘. Process No of slabs
. No of solids
Pt toolbar Viewbar | vootumtpmne
No. of load cases
= o) rF No of used materials
lﬁd* i ~ DEBUG
i 1 Fulltree ()
a !
8 4
IJ .-II.
x Input panel
s INPUT PANEL & All workstations @
_ @ "Ti = Nl[atergmlps . @ Alags - -
Wi By @H@as Qe gﬂa
@ a Fed » il
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1.1. General

The objective of this manual is to show a way of modelling a scaffolding (class 3) by using SCIA Engineer. In

this manual a simple example is elaborated.

The following steel scaffolding will be treated in this course:
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We will use a system of Layher in this example. On the website of Layher, documentation about their system

can be found and downloaded: https://www.layher.nl/en/Documentation
Of course, other scaffolding systems are possible with SCIA Engineer as well.

Now you have the choice to start from scratch or to start from a template file.

To save time for later projects, it can help to work with a template file , where you have already defined

several things, such as:
project data ;
national annex parameters;
materials ;
cross-sections
hinge types ;
load cases and combinations (linear, nonlinear, stability).

BV —2024/03/01



1.2. Project data

When starting a new project, the following project data are chosen:

e Structure : General XYZ (or Frame XYZ)
e Material : steel S 235 and timber C24

+ National Code : EC - EN

e National Annex : Belgian NBN-EN NA

Project data

DATA

Structure:

Narme:

Part:

Description:

Author:

Date:

Basicdata Functionality Actions UnitSet Protection

Scaffolding training

Scaffold
BV

01,03.2024

@ General X¥7

MATERIAL

Concrete
Steel

Material 5235 ¥
Masonry
Aluminium
Timber

Material C14(EN3Zv ...
Steel fibre concrete
Other

CODE
National Code:

B = )

National annex:

I I Belgian NBN-ENMA v | .

OK Cancel

Following functionalities should also be ticked on:

*  Property modifiers

e Nonlinearity (+ all options for nonlinearity on the right-hand side: Beam local nonlinearity
, Initial imperfections

Support nonlinearity/basic soil spring
support/soil spring )
«  Stability

, Geometrical nonlinearity & Friction

e Steel > Scaffolding (or Aluminium > Scaffolding if you would model with material aluminium)

Project data

*

Basicdata Functionality Actions UnitSet Protection

GENERAL

Property modifiers @
Model modifiers
Parametric input
Climatic loads Ef,
Mobile loads
Dynamics
Stability [
Nenlinearity gﬂi
Structural model %
IFC properties
Prestressing
Bridge design
Construction stages

DETAILED
4 MNonlinearity
Beam local nonlinsarity @
Suppert nonlinearity/ basic soil spr @
Initial imperfections @
Geometrical nenlinearity m
General plasticity
Compression-only 20 members
Cables
Friction support/Seil spring m
Membrane elerments
P Subsoeil
4 Steel
Plastic hinge analysis
Fire resistance checks
Steel connections
Scaffelding @

0K Cancel

On the Actions tab you can deactivate the automatic code combinations option since specific combinations

for scaffolding structures will be created:

BV —2024/03/01

CODE COMBINATIONS

Automatic

Note: you can change project settings or functionalities afterwards via Menu bar > File > Project settings
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1.3. Materials
You can open the materials library via Menu bar > Libraries > Materials

For the material, S 235 is generally used. For the standards you could create a copy of the S 235 material
with a higher self-weight to consider the additional weight of the rosettes.

According to the Zulassung of Layher (Z-8.22-64) you can calculate with a yield strength of 320 MPa for the
S 235 material (for the cross-section RO48.3X3.2, so not for the diagonals/bracings with thickness 2.3 mm),
so you can change this in the material properties of the material:

B Materials X
FEIEGIEE «» T Smd A Y
$355 NC Mame $235_yield 320

5420 NC 4 Code independent

Hz40LA
- Material type Steel
H3z0LA Thermal expansion [m/mK] ©-01e-003
H360LA Unit mass [kg/m"3] T850.00
H4ooLA E modulus [MPa] 2.1000e+05
H260LAD Poisson coeff. 0-3
H300LAD Independent G modulus
H340LAD G modulus [MPa] 8.0769¢+04 Thickness Range Strength Reduction - § 235_yield 320 X
H380LAD
H420LAD Log. decrement (nen-uniform d 0-15 Lower limit[mm] Condition Upper limit[mm] fu [MPa]
5220GD+ZA colour [N [ o ] =<t 0 320.0 360.0
S250GD+ZA Thermal expansien (for fire resi 0.01e-003 2 20 <te= 80 215.0 360.0
5280GD+ZA Specific heat [J/gK] §.0000e-01 = 0 <te<= 0 0.0 0.0
$320GD+ZA Thermal conductivity [W/mK] 4.5000e+01
S350GD+ZA Price per unit [€/kg] 1.00
S220GDHAZ
4 EC3

5250GD+AZ
$380GD+AT Ultimate strength [MPa] 360.0
S320GD+AZ Yield strength [MPa] 235.0
5350GDHAZ I Thickness range I
DX51D+Z
DX52D+Z
DX53D+Z

New Insert Edit Delete Close f=calz 2Lt Canice!

Floorboards can also be inserted as members. The average weight of these elements differs from the weight
of material S 235 (due to holes in these elements, another thickness of the elements, ...). That is why it is
chosen to insert an additional material in SCIA Engineer, in which the weight will be adapted. This weight
can be determined as shown below.

A distinction is made between floorboards of 19 cm and 32 cm. For each of them an average weight is
calculated.

Name Weight [kg] Length [m] [kg/m]  Average \
Floorboard 32/307 23.2 3.07 7.56
Floorboard 32/257 19.0 2.57 7.39
Floorboard 32/207 15.7 2.07 7.58
Floorboard 32/157 12.2 1.57 7.77 | 8.20 kg/m
Floorboard 32/140 10.8 1.40 7.71
Floorboard 32/109 10.4 1.09 9.54
Floorboard 32/73 7.2 0.73 9.86
Floorboard 19/307 18.2 3.07 5.93
Floorboard 19/257 155 2.57 6.03
Floorboard 19/207 12.7 2.07 6.14 | 6.18 kg/m
Floorboard 19/157 10.0 1.57 6.37
Floorboard 19/109 7.0 1.09 6.42

It is assumed that the floorboards have a thickness of 4 cm. The weights of the floorboards are:
«  Floorboards 32 cm: p = % = 640.6 kg/m3

Note: in this example we consider a thickness of 4 cm for the floorboards to consider them as stiff elements.

Therefore, we shouldn’t perform a deflection check on these floorboards (the supplier should have design

tables for this).

8 BV —2024/03/01



14. Cross-sections

We can open the cross-section dialog via Menu bar > Libraries > Cross sections

use following cross-sections from the Profile Library :

. In our example we will

Name | Cross section Material
Standard R0O48.3X3.2 S 235-fy320
Ledger R0O48.3X3.2 S 235-fy320
Guardrail R0O48.3X3.2 S 235-fy320
Bracing R0O48.3X2.3 S 235
Floorboard — 0.32 m RECT (40; 320) FB 0.32
Toeboard — 0.15 m RECT (150; 20) C24
Diagonal lattice girder RRO30X20X2K S 235
Beam lattice girder R0O48.3X3.2 S 235-fy320

Note: the cross-sections Diagonal lattice girder and Beam lattice girder does not have to be created if we
will add these elements with a user block.

| E RGO E &~ O @B A v Y !
| B Standard - RO48.3%3.2 Name Standard |
| B Ledger - RO48.3%3.2 Type RO48.3X3.2

| B Guardrail - RO48.3X%3,2

| B Bracing - RD48.3%2.3

| ﬁ Floorboard - Full rectangular (40; 320)
i ) Toeboard - RECT (20; 150)

Shape type: Thin-walled

Initial shape Not available

4 Source and Type descri...

Source description Stahl im Hochbau | 14.Auflage |

: Type description  Circular hollow section

4 Parameters
Material 5235 (ReH= 320 N/mm2 )

Circular hollow section RO48.3X3.2
Profile Library filter All cross-sections G

z

MNew Insert Edit Setup | Updateall | Close ‘

In you want to use a cross-section which is not present in the Profile library (e.g. the floorboard), you can use
the group Thin-walled geometric

If also this group does not contain your profile shape, you can use the General group to create a section by
yourself (for this you need the module sen.05).

BV —2024/03/01 9
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1.5. Structure

First a line grid (2D or 3D) can be added to the model. When adding elements, the line grid can be used to
snap to.

It could be practical to use layers (Menu bar > Libraries > Layers ), which can help you later to quickly
select a certain group of elements:

B Layers %
CER N BT A v Y

Standards yes MName Standarcs

Ledgers yes Comment

Guardrails yes Colour

Bracings yes Structural modelont _“o
O yes ructural model only

Toeboards yes Current used activity yes

Load panels no

Note: the toeboards will be modelled only for presentation purposes, so you can put them on a layer with
property ‘Structural model only’ = Yes.

Then the elements can be added to the model. You can find the 1D members in the input panel as functions
1D Member, Beam and Column (Input panel > Workstation Structure > Category 1D M embers).

Via ALT and right-mouse click you can use the Marking menu (available in the new interface since
SCIA21.1) to quickly launch the 1D Member or Column command in the Model branch.

You can make use of the Modify commands such as Copy and Multicopy to quickly create additional levels
of the structure. You can use the Marking menu again to quickly launch the Copy or Multicopy command in
the Modify branch:

I 4 MODIFY

~ e mE
N A
A u =

- b
i b u
= 4 -~ X
a
MODEL

If you quickly want to edit some parameters (node coordinates, members names, load values, ...), it could be
practical to use the Input table (available in the new interface since SCIA21.1) via Menu bar > Tools >
Input table .

A second way of modelling the structure is by making use of user blocks . In that way you create only once a
block that you want to reuse and each time you need it, you can load it into your model.

The folder, where the user blocks should be stored, can be found through Menu bar > View > Global Ul
settings > tab Templates & directories > Show direc  tories for ‘User block libraries’

Global Ul settings *
Environment Templates & directories  Other
TEMPLATES
Print picture path  iraphicTemplates\A4_Fortrait_Scialogo.epd

Overview drawings manager _ C-\Usersbjorn\ESA24.04User\GraphicTemplat

PROGRAM DIRECTORIES*
Show directories for  User block libraries v

Directories L

Cih\Users) \Documents\ESAZ24.0\UserBlocks)

10 BV —2024/03/01



Then you can import the user block with Input panel > Workstation Structure > Category Impo

Blocks > User blocks

Il QW

Structure -~
Import & Blocks

All tags

Es

INPUT PANEL

A L ke

rné&

It is also possible to import directly from CAD software. To import it you must go to Menu bar > File > Open
from and choose the desired format (XML file , Revit file , Tekla file , IFC file, ...):

Do # @ @ © o ‘a

I Project browser

New Ctri+N

fm Open Ctri+0

r Open from > )L xMLfile
Recent projects (3 Ll Ravit file

[B) Project settings @ Tekla file

[ save ctriss | [ SONFfile

Saveas Ctri+Shift+S @ FRILO GEO Building Model (FGBM)

ﬁ} save all @ SAF model

B Update from » @ Bimplus
Export to 3 @ EBiMcloud
Print p | [ rFefite

» Close Project Ctri+F4

[F] Closeall

B Quit Alt+Fa

You can also import with the direct links with Revit or Tekla Structures. Even IFC import can be used, but
then the model should be cleaned up (align, ...) with the BIM toolbox because with the IFC format we are
importing a structural model, which should be converted to an analytical model.
It is also possible to import a DWG or DXF file with Input panel > Workstation Structure > Category

Import & Blocks > Import DWG, DXF, VRML97 . You can import the lines and assign the elements later or
you can directly convert the lines into beams.

‘ 7 Import - C:\Users\bjorn\OneDrive - SCIA nv\Files (handleidingen, .\ Scaffolding!\Steel Scaffolding Model.dwg

BV —2024/03/01

|
LAYERS

I Toeboards

Enable all

Disable all

3 OpenGL in preview window

OpenGL selection
Show all objects

ENTITY TYPES

Enable all

Disable all

o x
SELECTION MODE
import all
L Cancel
Centre v
Sizes
30.020 X 1.270 X 20.180
ToOLS
Connect curves v Start
Number of vertexes on polyline substituting imported splins 30
Import 3D faces as solids
Import lines and polylines with nonzerc thickness as solids
g (O
T R
3
3
3
“’I
LR AL
Qg e

11



Advanced Package Training — Scaffolding

For our structure we will start with adding a 2D line grid. You can go to Input panel > Workstation

Structure > Category Grids & Storeys
direction and 1.09 m in Y direction:

> Rectangular grid . We create a grid of 2.07 + 10*2.57 + 2.07 in X

Line grid >
Input data for 2D Line grid
ol el s i fSea i kol a4 __-I-_"_|I-8
2m L 25w | 250 | 25w m|mrm1 zmlmTum1 2500 | euny ¥
1 1 I | 1 a| | | | | B= I :
f T T T T T - T 1 T Tz =
OB GHEORNCHGECEOMOONOSCES
[ AN
z #
Q@ e
DIRX . |DRY .
Type s v | e EEI
Mame X[ml ckIm]l Rep SL A Mame  Y[m] dy[m] Rep sL
1 A 0.000 ne v 11 0.000 ne v
2 B 2070 2070 1 m v z 2 1.090 1.090 1 no v
3 C 4640 2,570 10 - * 0.000 0.000 0 v
4 D T-210 no ¥
5 E 9.780 no v
6 F 12.350 e v
T G 14.920 e v
8§ H 17.490 no ¥
g | 20.060 o v
10 J 22.630 e v v
Generate name automatically Generate name automatically
oK Cance‘l. |

Then we can use the snapping setting Line grid (you can find the snapping settings in the status bar) to add
the standards as column (define the columns as type ‘column (100)’, ‘gable column (70)’ or ‘secondary
column (60)’, so the coupler check can be performed later), the ledgers as beam and the diagonals as
member. The standards have a length of 2 m and the ledgers have lengths of 1.09 m, 2.07 m and 2.57 m.

SNAPPING

\4

LC1wv

Magnet Snapping

Tracking Guides

Line grid
Dotgrid :0: =
Endpoints / Nodes

Midpoints / Centers

Intersections

Normal & Tangent

Line divisions

Points on line

Surface edges

12

0B|8|8|0BE #1880

Solid vertices

BV —2024/03/01



Define the diagonals as type ‘wall bracing (0)’ or ‘truss diagonal (90)’ (so the coupler check can be
performed later). The diagonals are entered with an eccentricity ey (in the y direction) of 48.3 mm (width of
the profile). This value should be given in positive or negative, depending on the direction of the diagonal.
This way the wind bracings are truly on top of the other members and not in between.

without eccentricity with eccentricity

For a ledger of 1.09 m, we will put the floorboards (with a width of 0.32 m) on 0.225 m from the edges of the
ledger and with 0.32 m between each other:

i ] 320 ‘ 320

| |

| 1090 |

Therefore, the snapping settings Midpoints / Centers and Points on line could be used:

wv ™
Magnet Snapping Q

Tracking Guides 3

Linegrid £

Dot grid 10}

Endpoints [ Nodes. N\,

I Midpoints | Centers (&)

Intersections ]
Normal & Tangent &=

Line divisions  {

ol [SIIGHS o o] (S 1SAS

Points on line %,
Length 0.225
Repeat 1

Start Both

Sufaceedges g (O )

solid vertices [ (0 )

Now we have added the floorboards on the first level and we copy the ledgers at the 2 m level three times: 2
times over a distance of 0.5 m in Z direction (for the guardrails) and 1 time over a distance of 0.075 m in Z
direction (for the toeboards). Then we change the properties of these copied elements to the correct cross-
section and layer.

BV —2024/03/01 13
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For the lattice girder we could make use of a user block (if we have created the block before):

¢
e s

5CF it N

/

] ; ] ) L

(RN} (AN

™
L
£

The folder, where the user blocks should be stored, can be found through Menu bar > View > Global Ul
settings > tab Templates & directories > Show direc  tories for ‘User block libraries’

Then you can import the user block with Input panel > Workstation Structure > Category Impo  rt &
Blocks > User blocks and select the block from the User library.

Import user block X

Import type Structure withallcv

Import structure into: Identical layers by v
Load cases Collect library iten v
Cross-Sections Collect library iten v
Nonlinear functions Collect library iten v
Load groups Collect library iten v

Other libraries Collect library iten v

OK Cancel

Note: in our example the lattice girder will be attached to the rosettes of the standards. There are also
systems of lattice girders which connect with right angle couplers to the standards. In that case you will give
the lattice girder an eccentricity and you can connect them to the standards by using a Cross-link at each
connection point (Input panel > Workstation Structure > Category Boundary conditions > Crosslink).
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.) commands to quickly model the

.) and select (Menu bar > View > Visibility or right-clicking

on a property in the property panel and choosing Expand selection , ..

Now you can use modify (Copy, Multicopy , ..
remaining part of the structure.

15
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i
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\4.. (W W e e e I»\

INYNINY GGG S

~<.. AN BN ENE BN R NN AL R

[y

Vi) BN Y N Nl N e

T

with load to 1D & edges ).

In our example we will add a load panel for the three sides of the scaffolding (LP1, LP2 and LP3; so not on
the side of the wall) and on the top (LP4) and the second top floor (LP5). For the side panels the load will be
transferred to all directions (especially when there is a net around the structure). For the floor panels we will

Load panels are entities that are not considered in the FEM analysis. The stiffness is thus not considered in
transfer in 1 direction (so the load is transferred to the floorboards).

To transfer surface loads to line loads on the beams, we will make use of load panels (Input panel >
the calculation, but they can redistribute the applied surface load to their edges and intermediate beams.

Workstation Structure > Category Load Panels > Load

BV —2024/03/01
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1.6. Model data

Now we will add several types of model data to our model: supports (base jacks and anchors), hinges on
beams (couplers and hinges on the floorboards and diagonals) and beam nonlinearities (gaps).

You can find these input data via Input panel > Workstation Structure > Category Boun  dary conditions

1.6.1.  Supports

You can use the Marking menu again to quickly launch the Support In Node command in the Model
branch:

r\ <S>
A

- Support In Node
v

f o
8 o

MODEL

We will add the supports for the base jacks (at the bottom nodes of the lowest standards) as nonlinear
supports. In the vertical direction these supports can only take pressure and no tension. This is entered in
the Z direction with rigid press only . The rotations are taken free in all directions.

For the degrees of freedom according to the X and Y displacements, the code EN 12812:2004, Annex B is
applied. In this code, friction coefficients between various materials are given. If we suppose that the
scaffolding is placed on wood, we can see in this code that the maximal and minimal friction coefficient

between wood and steel is 1.2 and 0.5. In our model we used a value of 0.50 to be on the conservative side.

For C flex alarge value is taken. This corresponds to a large rigidity of the support in X and Y direction
before the friction is exceeded.

B Suppertin node

4 Geometry

Name

Type

Angle [deg]
Constraint

X

From reaction
C flex X [kN/m]
miju X

Y

From reaction
Clex Y [kN/m]
mju ¥

P

Independent friction
Rx

Ry

Rz

Default size [m]

Node

System

Snl
Standard

Custom
Friction

Z

10000,00

0,5

Friction

Z

10000,00

0,5

Rigid press only

Free
Free
Free
0,200
N1

GCS

oK

g Cancel §

Note: independent friction is turned off since this corresponds to a single support that could slide in two
directions. For instance, the foot of a scaffolding support. There would be friction behaviour defined in X and
Y directions, linked to the vertical reaction. The vertical reaction contributes to both horizontal directions

together.

16

BV —2024/03/01



We will also add anchors to connect the scaffolding to the wall behind. We will add a row of supports (only
translations in X and Y direction are setasrigid )at4m,8m,12m, 16 m and 20 m . For constructions
over 20 m high, this needs to be performed every 2 m upward.

B Support in node

Hame Sn25

Type Standard
Angle [deg]
Constraint Custom

Rz
% Rigid
fz Y Rigid
7 Free
Y Rx Free

®\Ey Ry Free

Rz Free

Default size [m] ©.200

System GCS

" X

X

g

)Z 4 Geometry
< .

OK

Cancel

4 4 o y o—rp —> aEiEBam

AN N N Z Z .4
N B v v

N N AN Z Z 2z

N b . < Z Z
- - v b

AN = AN Z Z Z

2\ AN N s Z Z
AN v

N\ . N i 4 Z

AN N AN Z >4 L
— <

B =~ . p Z Z

.Y ~ b Z Z p
- - v v

=4 4 4= 4 4 -4 4= =4 - 4

Note: adding nodal supports like this is a simplification of the reality. In reality a tube will be connected to the
column (with a crosslink) and at the end of the tube (side of the wall behind) a nodal support as described
above could be added.
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Advanced Package Training — Scaffolding

1.6.2. Hinges on beams
Couplers - general principle

Various coupler types are available in SCIA Engineer. For the different couplers, go to Menu bar > Libraries
> Structure and analysis > Hinge type .

. I::] % ; le'ELI.\'E click here or press
£ Layers
E Materials
I Crosssections

[E] image gallery
Paperspace gallery
| Load cases, combinations )I
Loads [
| Structure and analysis » I E Buckling groups
Toals » I- 15 Named item
Steel » [EIJ Effective section properties
Subsoil and foundation » 15' Cross section list
Drawing tools ’.. ] Fabricated CSS & product range

. ﬁ Orthotropy

IL Nenlinear functions

I bm Hinge type I
= Initial deformations

In this Hinge type library you can choose following non-manufacturer types (from EN 12811) for the
parameter ‘Hinge type

Right angle Friction sleeve Swivel Base jack Parallel General

Note: if the functionality Scaffolding is not ticked on in Menu bar > File > Project settings > tab Functionality
you will not be able to see the hinge type library.
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For these couplers, not only the rigidities are entered in a flexible or nonlinear way, but also the maximal
allowable forces are defined, as displayed below for the Right angle coupler:

B Hinge type X

Name Rightangle (EN74-1 Class B)

ux Rigid v
uy Rigid v
uz Rigid v
fix Monlinear v

SHiff - fix [MNm/rad] 7.5000e-03
Fun - fix RA-B-MT Vo
fiy Nenlinear v
SHff - fiy [MNm/rad] 1.5000e-02
Fun - fiy RA-B-MB1 Yo
fiz Nonlinear -
Stiff - fiz [MNm/rac] 7-5000e-03
Fun- fiz RA-B-MT ¥l
Hinge type Right angle
Material Steel v
Picture
Nk [kN] 15.00
Vyk [kN] 30.00
Vzk [kN] 15.00
Mk [kNm] 0.13
Myk [khim] .80
Mzk [kNm] 0.13

| ok Cancel |

The rigidities and maximal forces are taken from the code EN 12811-1 Annex C. These tables and figures
are added in Annex A of this manual.
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Advanced Package Training — Scaffolding

Couplers of manufacturers in SCIA Engineer

Not only the types that are mentioned in the code are available in SCIA Engineer. You can also find couplers
from manufacturers in the library: Cuplock, Layher and Catari (the Catari coupler is available since SCIA

Engineer 20):

Name

ux

Stiff - ux [MN/m]
Fun - ux

uy

uz

fix

Stiff - fix [MNm/rad]
Fun - fix

fiy

Stiff - fiy [MNm/rad]
Fun - fiy

fiz

Stiff - fiz [MNm/rad]
Hinge type

Material

Picture

Nxk [kN]

Vyk [kN]

Vzk up [kN]

Vzk down [kN]

Mxk [kNm]

Myk [kNm]

Mzk [kNm]

Cuplok

Nonlinear v
4,3640e+01

Cuplok-N WP
Rigid v
Rigid v
Nonlinear v
1,8270e-02
Cuplok-Mx S
Nonlinear v
6,5000e-02
Cuplok-My P
Flexible v
2,5000e-03

Cuplok

Steel v

54,12
0,00
18,15
21,78
1,04
2,29
0,00

fiy
Stiff - fiy [MNm/rad]
Fun - fiy

fiz

Hinge type

Material

Picture

Nxk# [kN]

Vyk [kN]

Vzk [kN]

Mxk [KNm]

Myks [kNm]

Myk- [kNm]

Mzk [KNm]

Catari (Universal System US)
Rigid

Rigid

Rigid

Free
Nonlinear
3.8950e-02
Catari US - My
Free

Catari US
Steel

47.20
9.10
19.90
0.00
139
1.30
0.00

Layher

Variante K2000+

Layher
Variante ||

Layher

Variante LW

Name
ux
uy

Stiff - uy [MN/m]
uz
fix

Stiff - fix [MNm/rad]

Fun - fix
fiy

Stiff - fiy [MNm/rad]

Fun- fiy
fiz

Stiff - fiz [MNm/rad]

Hinge type
Material
Picture
Nxk [kN]
Vyk [kN]
Vzk [kN]
Mxk [KNm]
Myk [KNm]
Mzk [KNm]

Layher (Variante K2000+)
Rigid v
Flexible v
4,8500€+00

Rigid v
Nonlinear v
1,3876¢-03

Layher K2000+ -Mx Wliens
Nonlinear v
7,6680e-02

Layher K2000+-My v ...
Flexible v
5,1000e-03

Layher (Variante K2000+)
Steel v

34,10
11,00
29,04
0,58
1,11
0,41

ux Rigid

c

SHiff - uy [MN/m]
uz Rigid

SHiff - fix [MNm/rad]

Fun - fix

Stiff - fiy [MNm/rad]

Stiff - fiz [MNm/rad]
Hinge type
Material Steel

Picture
Nk [kN]
Vyk [kN]
Vzk [kN]
Mxk [KNm]
Myk [KNm] 0,75
Mzk [KNm] 0,41

24,97
7,37
19,14
0,37

Name Layher (Variante II)

y Flexible v
4,8500e+00

fix Nonlinear v

1,8066e-03

Layherll -Mx v ..

fiy Nonlinear v

6,5820e-02

Fun- fiy Layherll-My v ..
fiz Flexible v

5,1000e-03

Layher (Variante 1)

Name
ux
vy

Stiff - uy [MN/m]
Fun- uy

uz

fix

Stiff - fix [MNm/rad]

Fun- fix
fiy

Stiff - fiy [MNm/rad]

Fun- fiy

L

Stiff - fiz [MNm/rad]

Fun- fiz
Hinge type
Material

iz

Picture
Nock KN
Vyk [kN]
Vzk [kN]

Mxk [kNm]
Myk [kNm]
Mzk [kNm]

Layher (Variante LW)
Rigid

Nonlinear

5.3330e-01

Layher Variante LW - Vy
Rigid

Nonlinear

2.4620e-03

Layher Variante LW - Mx
Nonlinear

1.1560e-01

Layher Variante LW - My
Nonlinear

1.0000e-02

Layher Variante LW - Mz
Layher (Variante LW)
Steel

38.61
18.26
34.87
0.58
132
0.44

Note: ‘Layher Variante LW’ was called ‘Layher Variante HS’ before SCIA Engineer 20.

20
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As you can see each of these couplers has its specific nonlinear functions and maximal forces, which are
stored in the SCIA database and which are automatically assigned when you choose the desired coupler

type.
You have to select the appropriate material (steel or aluminium), because this will have an influence on the

safety factor of the coupler: when choosing for the material steel, the safety factor will be taken out of the
National Annex of EN 1993-1-1, while for aluminium the National Annex of EN 1999-1-1 is used.

In our example, a coupler of Layher is being adopted (type Variante K2000+ ). The values for Nxx, Vyk, Vz,
Mxk, Myk and Mz« are automatically filled in (taken from Zulassung Z-8.22-64). The equation for the rotation is

given by ¢q [rad] = M/(9140 — 73.6M) and is presented by following curve:

120

100

80

60
40 /
20 /

0 0,01 0,02 0,03 0,04 0,05 0,06

M [kNem]

0

@ [rad]

According to this curve, a nonlinear function is linked automatically to the coupler:
.- Nonlinear functions X

H-IEFH «2 O 2w [ Rotation
| Layher K2000+ -Mx
Layher K2000+ - My

Mame Layher K2000+ - My
Type Rotation
Positive end Free
Negative end Free
4 Impulse
1 [rad,kMNm] -0.0562 { -1.00
2 [rad,kNm] -0.0246 | -0.50

3 [rad kNm] ©.0127 / 0.60
4 [rad,kNm] -0.0065  -0.40
5 [rad,kNm] 0.0026 { 0.20
6 [rad,kNm] 0.0026 [0.20
7 [rad,kNm] 0-0065 /0,40
& [rad,kNm] 0.0127 /0.60
9 [rad,kNm] 0.0246 [ 0.50
10 [rad,kNn 0.0562 / 1.00

Create new function | New Insert Edit OK

Note: if you want to add other types of (manufacturer) couplers to the library, you can create the nonlinear
functions by yourself. In order to do this easily, you can use the Excel file ‘gvSEN NonLinear Function Input -
rev0l’ from the SCIA garage (https://resources.scia.net/en/garage/sciagarage.htm). You also have to fill in
the maximal allowable forces in the hinge type window.
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We will add as hinges the library item Layher Variante K2000+ to both extremities of the ledgers and
guardrails in our model.

For the connection between two standards , we will consider that the standards are rigidly connected. The
overlap length between two columns is 200 mm > 150 mm, so the columns are rigid in the x direction.
Moreover, the margin between two columns is 3.9 mm (= 48.3 mm — 2 x 3.2 mm — 38 mm), so this is less
than 4 mm. Because of this, also the degrees of freedom in the y and z directions are rigid. This is also
mentioned in the code EN 12811-1 art. 10.2.3 (1.1.1.1) (the connection column - column can be considered
rigid in the modelling, a hinge will not be entered at the extremities on the standard).

For the connection between the floorboards and the ledgers , you can consider the rotation around y axis
as free (and all other degrees of freedom as rigid).

The boundary conditions on the diagonals will be discussed in the next chapter.

1.6.3. Diagonals

The Zulassung of Layher (Z-8.22-64 Layher AR or Z-8.22.939 Layher LW) describes how to consider the
spring stiffness for the diagonals:

"When verifying scaffolding, the vertical diagonals including their connections must be taken into
account with a displacement spring with the design values according to Table 7, regardless of the
execution."

Tabelle 7: Bemessungswerte der Steifigkeit der Wegfeder der Vertikaldiagonalen
Bemessungswert der Steifigkeit der
Feldhohe H | Feldiange L | Stablange Beanswﬂfﬁz‘;"e' Cud gf; g‘;‘gmmﬂg
[mm] [mm] (mm] durch durch
Zug-Normalkraft Druck-Normalkraft

732 764 16.0 218
1088 1059 11.5 19.8
1572 1503 85 18.4

N 2072 1981 86 17,2
2572 2468 82 15,0
3072 2960 ] 13.2
732 1155 16,1 20,0
1088 1368 17.5 213
1572 1734 134 19,3

e 2072 2162 1.1 16,8
2572 2616 98 14.8
3072 3084 9.1 12.9
732 1607 14.8 18,1
1088 1766 16.0 18.9
1572 2063 171 19.0

. 2072 2434 141 16.7
2572 2845 12,0 144
3072 3280 10.7 12.5
732 2082 14,0 16,3
1036 2185 14,8 16,5
1088 2207 14,9 16,5
1400 2356 15,6 16,6

2000 1572 2451 16.0 16.5
2072 2770 167 15,8
2572 3137 14.4 13.6
3072 3537 12,6 11.8
4144 4462 10.4 8.1

2500 6144 6490 9.3 7.9

L. H siehe Anlage A, Seite 4

Together with the information of Table 8 nonlinear functions can be created in SCIA Engineer for each type
of diagonal.
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Tabelle 8: (Fortsetzung)

Tabelle 8: Beanspruchbarkeiten der Vertikaldiagonalen
Anschlusskopf
Anschlusskopf
K2000+* | Variantell" | ,Variante|B* [ VarianteIC"
Lochscheibe K2000+ | Varante |I” | JVariante IB* | .Vanante IC*
Lochscheibe
H . = - . = b . = L . 5 .
+ + + +
mm] | [mm) 2| 2 2| £ s | 2 g | 2 H L . = | =, EN T ER T | =
SRR AR R AR AR IR AL AR AR AD AR ool ol | 2| 22| s | 2| 2g g2
X J g X ] 8 N s L X < S o & & = o Rt T a3
2 S O i - S R I S B I | 5|5 |2 |5|F|8| 5| 5|2 | 5|5
N - e T N R
Druck-Normalkraft N, g4 [kN] »
Zug-Mormalkraft N™', g,
732 | 211 [133 ~ 9 vee [N
1088 | 17,2 [ 133 732 | 262 _
1572 | 161 [124 84 [84[66[78[78[66[66]66]66 1088 | 25.8
500 1072 [ 187 [12.4] o8 = 1672 | 241 B4 8466 | 78] 78] 66 ]65]66]66
- : 500 135 66
2572 | 152 [119 84[84]66[78[78][66][66[66]66 2072 | 235 =
3072 | 115 [11.2 = 2572 | 232 84 [84[66[78]78]65][66]66]66
732 [ 200 [135 3072 | 231 =
1088 | 231 [135 B 732 |17 B
1572 | 187 [135 1088 | 243
1000 : 1 66
' 1572 | 2756
;ZZ; 3'; 35 84 (84|66 |78|78|66|66|66|66]|| 1000 —-—1—>--—135 66
- . : 84 |84 |66 (78| 78|66|66|66]|66
3072 | 10,8 [105 2572 | 246 [ e E I R El Etelt Bt
732 | 17,8 [125 3072 | 241
1088 | 204 [135 B 732 | 198 —
1500 |1272 [ 193 [135] [ 84 [84]66]78[78[66]66]66]66 1088 | 22,0
2072 [ 155 [135] — 1500 |52 [ 224 | o) oo [B4 [84[66[78[78[66][66][66]66
2572 | 123 [119 84[84[66[78][78][66]66][66]66 072273 ] 777 =
3072 97 [96 = 2572 | 26,8 84846678 78]66]66]66]66
732 [ 166 [12.2 84[84[66[78[78[66[66][66]66 3072 | 256 =
1036 | 17,9 [12.8 = 732 | 180 84846678 78]66]66]66]66
1088 | 17,7 129 1036 | 20,8 —
1400 | 163 [135] o 1088 | 21.2
2000 | 1572 [ 154 [135] ™ 1400 | 22,0
2072 | 128 [124 8418416678\ 7866|66)| 6666 000 1572 [ 226 |135| 66
2572 [ 105 [102 2072 | 245
3072 85 83 [ %57 84 |84 |66 (78| 78|66|66|66]|66
4144 | 54 [53]53[53[53[53[41][4a1[a1[41]41]41 3072 | 276
2500 | 6144 [ 22 |21 [21[21[21[21[16[ 16|16 16] 16 1.6 4144 | 255
LH  siehe Anlage A, Seite 4 2500 | 6144 | 247 [135] 66

For the Layher Allround system with coupler K2000+ the nonlinear function for a diagonal with height 2000
mm and field length 1088 mm would be:

Stiffness wedge = 2 * (Cv,d,tuve * Ctotal) / (Cv,d,tube — Crotar)

with Cudube = EA / (L*yM) = 21000 KN/cm2 * [17 * (4.83 cm / 2)2- T * (4.37 cm / 2)7] / (220.7 cm * 1.10)

= 287.51 kN/cm

Pressure part:
0 2*(287.51*16.5)/(287.51 - 16.5) = 35.01 kN/cm
0o 17.7 kN /35.01 kN/cm = 0.0051 m

Tension part:
0 2*(287.51*14.9)/(287.51—14.9) = 31.43 kN/cm
0 21.2kN/31.43 kN/cm =0.0067 m

Monlinear function

IF [MN]

00051
i 0000

u[m]

00067

Flexible

NEGATIVE AXIS

oK

Cancel

RHILE AR_K2000+_H2000L10¢
VARIABLE OM X-AXIS OF ...
u [m] F [MN]
Translation

20,0000 0,0000

POSITIVE AXIS
30,0067 0,0212
* 0,0000 0,0000 il bl v

BV —2024/03/01

23



Advanced Package Training — Scaffolding

So for the connection between the standards and the diagonals we can also use Hinge on 1D. In this case
you can define the rotation around y axis as free or as flexible with a certain stiffness. There can be a
discussion about the rigidity around the z axis. In this example, it is set on rigid, although it cannot be
completely considered as rigid. If you want to enter an exact value, you must ask it to the supplier. On both
ends of the element, the rotation around the x axis and the translations in the y and z direction are ‘rigid’. We
define ux as nonlinear function for the specific diagonal.

¥ ' Hinge on beam >

Name H1302
Hinge type Standard v
Position Both v
ux Nonlinear v
SHff - ux [MN/m] 1,0000e+00
Fun - ux AR_K2000+_H2000L1088 Vi
uy Rigid
vz Rigid
fix Rigid
fiy Free

<[ €| €| ¢«

fiz Rigid
Member B1102

oK Cancel

Alternatively diagonals could be modelled via Nonlinearity 1D (Input panel > Workstation Structure >
Category Boundary conditions > Nonlinearity 1D ). Possibilities are:

* Type Gap: e.g. a margin of 1. mm. Note that this could cause issues during the analysis since
between 0 and 1 mm displacement there is no stiffness present and the ends of the element.

e Type Limit force and as direction Limit compression . If the subtype buckling (results zero) is
chosen, the diagonal will lose its stability and bears no load at all when the limit force is reached.
When the subtype plastic yielding is used, the diagonal follows the plastic stress-strain diagram
when the limit force is reached.

Another alternative is to use a coupler on the connection of the diagonal with the standard (for example
Cuplok-N as nonlinear function for ux)
1.7. Connect and check

After modelling the construction, it is recommended to check the input by using the command Check
Structure (Menu bar > Tools > Check structure ). Through this function the geometry is checked on errors.

After the check, the command Connect members/nodes (Menu bar > Edit > Modify > Connect
members/nodes ) is applied to the entire construction. With this function the different parts are connected to
each other. Since version 19.0 it is possible to execute the connect command automatically at the start of the
calculation.
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Chapter 2: Loads

According to EN 12811-1, two combinations should be considered for the structural design of a scaffolding: a
service condition and an out of service condition . The service condition corresponds with the self-weight
of the scaffolding, a working load on the scaffolding and a working wind load, while the out of service
condition corresponds with the self-weight, a percentage of the working load and the maximum wind load.

2.1. Load cases
There are three main types of loads which need to be considered (according to EN 12811-1, 6.2.1.):

 Permanent loads : these shall include the self-weight of the scaffolding structure, including all
components, such as platforms, fences, fans and other protective structures and any ancillary
structures such as hoist towers.

» Variable loads : these shall include service loads (loading on the working area, loads on the side
protection) and wind loads and, if appropriate, snow and ice loads .

e Accidental loads : the only load specified in the standard (EN 12811-1, 6.2.5.1) is the downward
loading on the side protection or guardrails (1.25 kN)

More details about the service loads can be found in Annex B and for the wind loads in Annex C.

We will define seven load cases in SCIA Engineer (Load cases, Combinations > Load Cases ):
e LC1 - Self-weight (permanent load)
* LC2 - Other permanent load (e.g. weight of toeboards)
 LC3 - Service load, service condition (variable load)
e LC4 - Service load, out of service condition (variable load)
» LC5 - Maximum wind load X, parallel to facade (variable load)
* LC6 — Maximum wind load Y, perpendicular to facade (variable load)
 LC7 - Working wind load X, parallel to facade (variable load)
e LC8 - Working wind load Y, perpendicular to facade (variable load)

B Load cases *

HIEFES «» O @B A Y
ILC1 - Self-weight Name LC1
LC2 - Other permanent load

Solver index (1)

LC3 - Service load in work Description Self-weight

LC4 - Service load max wind

i Permanent v
LCS - Max wind X Gtiony e
LCE - Max wind Y Load group LG1 L
LCT - Working wind X Load type Self weight v
LCE - Working wind Y Direction -Z ¥
New Insert Edit Delete Close

The accidental load is in many cases not considered in the analysis model.
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2.1.1. LC1 - self-weight

This load case is automatically calculated by SCIA Engineer. It contains the self-weight of all elements that
are present in the model (standards, ledgers, guardrails, diagonals, floorboards, toeboards).

2.1.2. LC2 - other permanent load

Since we have put the toeboards on a ‘Structural model only’-layer, their weight will not be considered in the
analysis. So we can add the weight as a line load on the structure (ledgers).

Weight [kg] Length [m] [kg/m]  Average
Toe board 15/307 6.3 3.07 2.05
Toe board 15/257 5.7 2.57 2.22
Toe board 15/207 4.3 2.07 2.08
Toe board 15/157 35 1.57 2.23 | 2.32 kg/m
Toe board 15/109 2.5 1.09 2.29
Toe board 15/73 1.5 0.73 2.05
Toe board 15/30 1.0 0.30 3.33

2.1.3. LC3 — service load, service condition

This load case represents the service load that operates over the entire main floor. ‘Main floor’ means the
most important/crucial floor of the scaffolding. If the load is put on this floor, it leads to the most critical
values.

In this example, a class 3 scaffolding has been inserted, so a surface load of 200 kg/mz2, or 2.0 kN/m2 will be
added (according to EN 12811-1 Table 3, g1, see also Annex B of this manual):

Table 3 — Service loads on working areas (see also 6.2.2)

Load Uniformly Concentrated load Concentrated Partial area load
class distributed on area load on area
load 500 mm x 500 mm | 200 mm x 200 mm q2 Partial area
a1 F F, kN/m? factor
kN/m* kN kN oy
/]
1 0,752 1,50 1.00
2 1,50 1,50 1,00 ==
3 2,00 1,50 1,00 -t S
4 3,00 3,00 1,00 5,00 0.4
5 4,50 3,00 1,00 7,50 04
6 6,00 3,00 1,00 10,00 05

This load is applied to the load panels and will be transferred to the floorboards.

Analogous above, also a service load is entered on the complete secondary floor if a scaffolding has more
than one decked level. ‘Secondary floor’ refers to the working area at the first level above or below the main

floor.

According to the code EN 12811-1, 50% of the service load must be put on the secondary floor, so we will

add a load of 1.0 kN/m2 to the second top load panel.

You can add loads via Input panel > Workstation Loads > Category Surface

2D.

26

Loads > Surface load on
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2.1.4. LC4 — service load, out of service condition

This load case represents an accumulation of materials and equipment for the complete main working area
(when the scaffolding is subject to the maximal wind load).

A percentage of the uniformly distributed service load (EN 12811-1, Table 3, gi1) acting on the working area
of the most unfavourable decked level. The value of the percentage depends on the class of the scaffolding:

» Class 1: 0% (no service load on the working area)
* Classes 2 and 3: 25%  (representing some stored materials on the working area)
 Classes 4, 5 and 6: 50% (representing some stored materials on the working area)

For our class 3 structure, we consider 25% of 2 kN/mz2, so we put a load of 0.5 kN/m2 on the top floor.

Note: in some cases, it can be necessary to input a non-symmetric load on the construction. So, it can be
important to input a load case, completely analogous to load case 3 or 4, but here the service load is only put
on half of the main floor. By executing this load case, the structure is eccentrically loaded, so effects that
counterbalance each other in a symmetrical load, are revealed here.

Sy

)
[N £ ‘ s

Fully loaded Half loaded

2.1.5. LC5 - maximum wind load, parallel to facade

The wind peak velocity pressure for our example is 0.496 kN/m2 (see Annex C for the calculation of this
value).

The wind force can be calculated according to formula (VSB 5.8) of publication “Nederlandse Annex voor
windbelasting op steigers” (Dutch Annex for wind load on scaffolds):
Fw =¢scq Cs-Crrqp(z) - Ay

*  CsCq structural factor (1 for height lower then 15 m, a reduction could be used for heights between
15 m and 50-60 m)
e G site coefficient, see figure VSB-6.2

1,0 - D 1,00

0,8 e
Cs “'"“‘“*- 0,75 (Gemeten 0,75)
0,6
o
0,4 [~ 0,40 (Gemeten 0,45)
02 1N 0,25 (Gemeten 0,30)

0 06,2 04 06 08 1

A = anbekleed
—a— B = netten 50% (k-waarde=0,%)
e = petten 90% (k-waarde=15)

------ D = volledige winddichte bekleding of sheeting

Figuur VSB-6 2 site coéfficiént Cs

e (¢ force coefficient
* qp(2) extreme wind pressure

s A, wind-catching area

So for an uncladded scaffold, Cs can be taken as 0.25 for ¢g = 1
Fy, =1.0-0.25-1.3-0.496 - Ay, = 0.161 kN/m? - A,
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Furthermore, we can assume that the members in the plane perpendicular on the wind load take up about
35% of the total surface of the construction, as shown on the drawing below:

Code EN 12811-1 86.2.7.4.1: To make allowance for equipment or materials which are on the working area,
a nominal reference area shall be assumed at its level over its full length. This area shall be 200 mm high
measured from the level of the working area and includes the height of the toeboard. The loads resulting
from the wind pressure on this area shall be assumed to act at the level of the working area.

The windcatching surface can be calculated from formula VSB 7.1 of publication “Nederlandse Annex voor
windbelasting op steigers” (Dutch Annex for wind load on scaffolds):

A‘b =A;- (Atotaal - Al) ! (1 - e(_O'BSl(n_l).AZ/AtOtaal))

For this case it leads to a percentage of 87%, so a surface load of 0.161 kN/m2 * 0.87 = 0.140 kN/m? can be
applied on the left load panel.

Note: when inputting netting on the structure you can adapt the 0.25 value depending on the type of netting.

2.1.6. LC6 — maximum wind load, perpendicular to fagade

In an analogous way, the maximal wind load is entered perpendicular to the facade on the structure.
Furthermore, we can assume that the members in the plane perpendicular on the wind load take up about
25% of the total surface of the construction, as shown on the drawing below:

Formula VSB 7.1 leads to a percentage of 27%, so a surface load of 0.161 kN/m2 * 0.27 = 0.044 kN/m2 can
be applied on the front load panel.

2.1.7. LC7 —working wind load, parallel to facade

The code EN 12811-1 §6.2.7.4.2 prescribes that if the scaffolding is into service, it only needs to be loaded
with the so-called working wind load: A uniformly distributed velocity pressure of 0.20 kN/m2 shall be taken
into account. To make allowance for equipment or materials being on the working area, a nominal reference
area as defined in 6.2.7.4.1, but 400 mm high, shall be used in calculating working wind loads.

The wind force can be calculated now with the wind load of 0.20 kN/m2:
F, =1.0-025-13-0.294-A, = 0.096 kN/m? Ay

Formula VSB 7.1 leads to a percentage of 89%, so a surface load of 0.096 kN/m2 * 0.89 = 0.085 kN/m2 can
be applied on the left load panel.
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2.1.8. LC8 - working wind load perpendicular to facade

In an analogous way, the working wind load is entered perpendicular to the facade on the structure.

Formula VSB 7.1 leads to a percentage of 39%, so a surface load of 0.096 kN/m2 * 0.39 = 0.037 kN/m2 can
be applied on the front load panel.

2.2. Linear combinations

Following EN 12811-1, 6.2.9.2 the load cases have to be combined in two different ways: the service
condition (service load in work and working wind loads) and the out of service condition (service load for
maximal wind and maximum wind load).

Note: the service load shall be taken as zero if its consideration leads to more favourable results.

For the combinations in Ultimate Limit State (ULS) , a safety factor yr of 1.50 on the load cases is taken,
conformable to the code EN 12811 §10.3.2. The safety factor ymo on the material is 1.10.

Note: for Belgium and Netherlands a factor of 1.2 is used for the permanent load, according to VSB and
VSBB (Dutch and Belgian association for scaffolding companies).

The ULS combinations are:
e CO1:1.2*LC1 + 1.2*L.C2 + 1.5*LC4 + 1.5*LC5 (max wind parallel + service load max wind)
e CO2:1.2*LC1 + 1.2*LC2 + 1.5*L.C4 + 1.5*LC6 (max wind perpendicular + service load max wind)
e CO03:1.2*LC1 + 1.2*LC2 + 1.5*LC3 + 1.5*LC7 (working wind parallel + service load in service)
e CO4:1.2*LC1 + 1.2*L.C2 + 1.5*LC3 + 1.5*L.C8 (working wind perpendicular + service load in service)

For the Serviceability Limit State (SLS) Vr and ym shall be taken as 1.00. The SLS combinations are:
e CO5:1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC5 (max wind parallel + service load max wind)
« CO6:1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC6 (max wind perpendicular + service load max wind)
e CO7:1.0*LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC7 (working wind parallel + service load in service)
e CO08: 1.0*LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC8 (working wind perpendicular + service load in service)

The linear combinations are created in SCIA Engineer (Menu bar > Libraries > Load cases, Combinations
> Combinations > Combinations ):

B ' Combinations X
= - E &2 [T Inputcombinations v

CO1 - ULS Max wind perpendicular Name CO1

CO2Z - ULS Max wind parallel Description ULS Max wind perpendicular
CO3 - ULS Werking wind perpendicular Type Lincar -ultimate

CO4 - ULS Working wind paraltel 7

CO5 - SLS Max wind perpendicular Aatplidiaay Mool "

CO6 - SL5 Max wind paraliel 24 Conterts of comliination

COT - 5LS Working wind perpendicular LC1 - Self-weight [] 1,20

CO8 - SLS Working wind parallel LC2 - Other permanent load [-] 1,20

LC4 - Service load max wind [-] 1,50
LC5 - Max wind X [-] 1,50

Mew Insert Edit Delete Close

Note: depending on the used code other factors can be used. E.g. “NEN-EN 13814 Fair ground and
amusement park machinery and structures” mentions a factor of 1.35 for the variable loads.
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We can change the safety factor for steel in SCIA Engineer in the National Annex (which can be accessed
via the status bar):

B Mar = B Steel setup x|

|BFAEE a2 0 @B A ¥ ] - Belgian NBN-EN NA Name Belgian NBN-EN NA
| Standard EN - Steel 4 St
eel
TR 3 - Member check
LR Y Fie resistance 4 Member check EN 19931
S_ L Cold Formed ? Bow Imperfections EN 1993-1-1: 5.3.2{3} b]

British BS-EN NA - Plated structural elements

Cypriot CYS-EN NA > Member Imperfection EN 1893-1-1

Pl reR ER MR . J 4 Partial Safety Factors EN 1993-1-1:6.1{

Mame Belgian NBN-EN NA ~ 4 Gamma Mo
Mational annex Belgian NBN-EN NA Value[] 1.10

Show both the Default EN and NA 4 Gamma ML

References Value[] 1.10

|“ EN 1990: Basis of struct...
EN 1990 (Basis of structural desi

4 EN 1991: Actions of stru...

4 Gamma M2

Value[] 1.25

r ITB Curves - General Case

EN 1991-1-3 (General actions- S P LTB Curves - Relled/Equivalent welded Case
EN 1991-1-4 (General actions -V P Interaction Method
|+ EN 1992: Design of conc... P Fire resistance
EN 1992-1-1 (General rules and | b Cold Formed EN 1993-1-3
EN 1992-1-2 (General rules -Stru B Plated structaralclements EN 1993-15

EN 1992-2 (Concrete bridges - Di
EN 1168 (Precast concrete prodt
|4 EN 1993: Design of steel ... v
EN 1993-1-1 (General rules and | E
EN 1993-1-2 (General rules - Strt
EN 1993-1-3 (General rules - Sug
EN 1893-1-5 (Plated structural e
EN 1993-1-8 (Design of joints) v

New Insert Edit 0K

2.3. Nonlinear combinations

To include the nonlinearities in our model (gaps, nonlinear functions, ...) we will perform a nonlinear
analysis. Therefore, we will create eight nonlinear combinations from our (linear) combinations (Menu bar >
Libraries > Load cases; Combinations > Nonlinear combinations ):

¢ NC1:1.2*LC1 + 1.2*LC2 + 1.5*LC4 + 1.5*LC5

e NC2:1.2*LC1 + 1.2*L.C2 + 1.5*L.C4 + 1.5*LC6

e NC3:1.2*LC1 + 1.2*LC2 + 1.5*LC3 + 1.5*LC7

e NC4:1.2*LC1 + 1.2*L.C2 + 1.5*LC3 + 1.5*LC8

* NC5:1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC5

e NC6:1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC6

e NC7:1.0*LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC7

« NCB8:1.0*LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC8

It is possible to import the linear combinations as nonlinear combinations with the button ‘New from
combination’ in the nonlinear combinations window.

We will set imperfections for these nonlinear combinations in the following chapter 3.

24. Nonlinear stability combinations

To investigate the stability behaviour of our structure, we will perform a stability analysis. Therefore, we
create four stability combinations from our linear combinations (Menu bar > Libraries > Load cases,
Combinations > Nonlinear stability combinations ):

 SNI1:1.2*LC1+ 1.2*LC2 + 1.5*LC4 + 1.5*LC5

¢ SN2:1.2*LC1 +1.2*LC2 + 1.5*LC4 + 1.5*L.C6

 SN3:1.2*LC1+1.2*LC2 + 1.5*LC3 + 1.5*LC7

 SN4:1.2*LC1+1.2*LC2 + 1.5*LC3 + 1.5*LC8

e SN5:1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC5

e+ SNG6: 1.0*LC1 + 1.0*LC2 + 1.0*LC4 + 1.0*LC6

e SN7:1.0"LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC7

e SN8:1.0*LC1 + 1.0*LC2 + 1.0*LC3 + 1.0*LC8

It is possible to import the nonlinear combinations as nonlinear stability combinations with the button New
from nonlinear combinations  in the nonlinear stability combinations dialog.
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hapter 3: Analysis & results

In SCIA Engineer different analysis possibilities are available, but which kind of analysis should we perform
for a scaffolding structure?

In code EN 12810-2, following table is mentioned:

Design Path 1 Path 2
stage Modular and frame systems Frame systems only
1 Tests for configurations, connection devices and components

213 Calculation for each system configuration of the standard set

Determination of &

Continuation of path 2 only ifer . =2 2;

2 if a. <2 change to path 1
3a | Analysis of the structure to determine the distribution of forces and moments using
3 Second order theory First order theory with amplification factors on the basis of
[e

3b | Analysis of the individual components and connection to verify that the resistance is adequate

One test on a representative section of a system configuration

4 Type 1 Type 2

For the verfication of significant load | For the verification of o
displacement behaviour

O o 15 the lowest elastic buckiing load factor to be applied to the design loads

So, if we are working with modular systems (such as the Layher system), we should always perform a
second order calculation.

This principle is also shown in the following flow chart of code EN 12810-2:

Tests for configurations, connection
devices, compenents

Choose a system
configuration

First order;
for frame
First of systems only
second
order theory

No Yes
Second erder i
Carry out second arder Carry out first order
analysis analysis

f

Apply amplification

factors
T
Apply the Fail wyaten
design not
cheeks acceptable

Repeat with
another
configuration

pass

Figure 1 — Flow diagram of the stages of the structural design
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The general procedure for first order and second order analysis is shown in the following diagram (following
EN 1993-1-1, chapter 5):

[ Structural Frame Stability ]

5.210)

1% Order Analysis

\—/ 'Y
Yes Ne 522(9b 5223 532aD
Global Imperfection ¢
5.3.2(6)
as N / \ ¥
8220 T Npu>25%Na — e
(menber)
eoif epinall
required members
2a 2 é) @
2% Order Analysis

T
Increase sway
effects with: Ne /' Members
1 - with e
1
-
a{r
52203 ;|_/ 522(7b
1, based on a global 1 taken equal to L
buckling mode
I
Stability Check in plane
522(Ma
Stability Check out of plane + LTB Check
Section Check
With:
* Mo elastic critical buckling mode
« L member system length
e b buckling length

32

BV —2024/03/01




Global analysis aims at determining the distribution of the internal forces and moments and the
corresponding displacements in a structure subjected to a specified loading.

A distinction is between the methods, which make allowance for, and those, which neglect the effects of the
actual, displaced configuration of the structure. They are referred to respectively as second order theory
based and first order theory based methods.

The second order effects are made up of a local/member second order effects (referred to as the P-4 effect)
and a global second order effect (referred to as the P-A effect).

P
H
-—J = T
| |
| X
* |
| L
|
i
M(X) = Hx M(X) = Hx + Pd + PAX/L
M(L) = HL M(L)= HL + PA
First order theory Second order theory

In the diagram of EN 1993 three paths are defined:
» Path 1: afirst order calculation will be executed;
» Path 2: a second order calculation will be executed with global (and bow) imperfections;
« Path 3: a second order calculation will be executed with the buckling shape of the construction as
imperfection.

The calculation will become more precise when choosing for a higher path. The lower paths will result in a
faster calculation, because a first order calculation can be executed without iterations, but this first order
theory may be used only when the displacement effects on the structural behaviour are negligible.

For our scaffolding structure, we should follow path 2 or 3 (since we should calculate with the second order
effect according to EN 12810-2).

So, when we are designing scaffolding structures; following workflow can be used.

» First a linear analysis can be executed to have a look at the global behaviour of the structure.

» Then we can perform a stability analysis to investigate which stability modes should be considered if
we want to follow path 3.

e Finally, we can create the nonlinear combinations with imperfections (global and local imperfections
if we want to follow path 2 or the stability mode as a global imperfection if we want to follow path 3).
We will execute the analysis with these nonlinear combinations and perform the checks with the
results of them.
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3.1.

Linear analysis

First, we can start with a linear analysis for a global stability check of the whole structure:
* Is the model calculating properly (are there no instabilities)?
¢ Are the reactions logic?

Pay attention that it is mandatory to perform a second order analysis with imperfections! When you would
perform the ULS checks with the linear combinations, a warning will be given in the output of the check.

3.11.
The bill of material

Bill of material

can also be found in the results workstation

of the process toolbar . In this table the

total length for each cross section is shown or the number of elements can be shown per member type and

per length.
Bill of material
Selection: Al
Type of sorting: Member (1D}
Summary
Material Mass Surface Volume
[kg] [m2] [m3]
Steel 13819.8 892.725 | 1.1050e+01
Timber 661.7 06.975 8.5566e-01
Total 14481.5 989.700 | 1,1906e+01
Steel (1D)
Member Material Count Unit length Length  Unit mass HMass Surface Volume
[m] [m] [kg/m] [kg] [m2] [m?]
Standard - S235(ReH 2 256 2.000 512.000 3.6 1820.7 77.824 2.3194e-01
RO48.3%3.2 320 N/mm2 )
Ledger - S235(ReH 2 141 1.090 153.6%0 3.6 546.5 23.361 6.9622e-02
RO48.3%3.2 320 N/mm2 )
Ledger - 5235(ReH 2 44 2.070 91.080 3.6 3239 13.844 | 4.1259%e-02
RO48.3%3.2 320 N/mm2 )
Ledger - 5235(ReH 2 208 2.570 | 534.560 3.6| 1900.9 B1.253| 2.4216e-01
RO48.3%3.2 320 N/rmma )
Guardrall - 5235(ReH 2 40 1.090 43.600 3.6 155.0 6.627 | 1.9751e-02
RO48.3X3.2 320 Njmm2 )
Guardrall - 5235(ReH 2 36 2.070 74.520 3.6 265.0 11.327| 3.3758e-02
RO48.3%3.2 320 Nfmm2 )
Guardrail - S235(ReH 2 176 2570 | 452.320 3.6| 16085 68.753 | 2.0490e-01
RO48.3%3.2 320 Nfmm2 )
Bracing - 5235 20 2.278 45.555 26 118.7 6.924| 1.5124e-02
RO48.3%2.3
Bracing - 5235 20 2.878 57.567 26 150.0 B.750| 1.9112e-02
RO48.3%2.3
Bracing - 5235 40 3.257 130.261 2.6 3395 19.800 | 4.3247e-02
RO48.3%2.3
Floorboard - FB8 0.32 54 2.070 111.780 8.2 916.6 80.482 | 1.4308e+00
Full rectangular
(40; 320)
Floorboard - F8 0.32 264 2570 | 678.480 8.2| 5563.3| 488.506| B8.6845e+00
Full rectangular
(40; 320)
Beam lattice 5235(ReH = 10 0.500 5.000 3.6 17.8 0.760 2.2650e-03
girder - 320 Nfmm2 )
RO48.3%3.2
Beam lattice 5235(ReH =z 4 5.140 20.560 3.6 731 3.125 9.3137e03
girder - 320 Nfmm2 )
RO48.3X3.2
Dizgonal lattice |5 235 24 0.619 14818 14 20.3 1.389 2.5810e-03
girder -
RRO30X20M2K
Totzl 1337 2925.891 13819.8| 892.725| 1.1050e+01

Note: the toeboards are not visible in this table since they are not considered in the analysis (they are on a
layer with property ‘structural model only’).
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3.2. Nonlinear stability analysis

Now we will perform a nonlinear stability calculation, which calculates the global buckling mode/shape
(eigenmode) of a structure under the given loading. We will have a look at the stability modes, to decide
which modes we want to impose as imperfection (according to path 3 of the EN 1993 diagram).

The nonlinear stability calculation is available with module sens.03.
The nonlinear stability combinations are already created in the previous chapter.

To obtain precise results, the number of 1D elements is refined through Menu bar > Tools > Calculation &
Mesh > Mesh settings (a minimum number of 5 elements is required):

B Mesh setup X

Mame MeshSetupl

I Average number of 10 mesh elements on straight 10 members 5 I

Average size of 1D mesh element on curved 1D members [m] 1,000
Average size of 2D mesh element [m] 1,000

Connect members/nodes

Setup for connection of structural entities

P Advanced mesh settings

B A& OK Cancel

Under Menu bar > Tools > Calculation & Mesh > Solver settings the Type of eigen value solver and
Number of buckling modes can be specified:

B Solver setup x

Mame SolverSetupl
Specify load cases for linear calculation
Specify combinations for nonlinear calculation
Specify global geometrical imperfections for calculation
Specify combinations for linear stability calculation
Specify combinations for nonlinear stability calculation
4 Advanced solver settings
General
Effective width of plate ribs
Nonlinearity
Initial stress
Linear stability
Nonlinear stability

lw w v v w

Type of sigen value solver Lanczos *
Number of buckling modes 1
Initial load factor 0,1
Load factor increment @,1
Maximum number of increments 10
Maximum iterations 20
Limit of nodal deformation - direction U_total ¥
Limit of nodal translation [m] 1,000
Solver precision ratio 1

Solver robustness ratio 1

D & &0 | OK pCancel

You can start with 1 or 2 buckling modes and evaluate if a global mode is found. If not, you can increase the
number of buckling modes or you can change the element that is too weak.

Since we have nonlinearities in our model, we must execute the nonlinear stability analysis  to take these
nonlinearities into account. We need to activate the functionality Geometrical nonlinearity and choose as
geometrical nonlinearity for 3" order (large deformation) in the solver settings (see also Annex D —
Nonlinear analysis).
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After the calculation we can have a look at the alpha critical (acr) values under Menu bar > Results >
Critical load coefficients

Critical load coefficients

N f

= 1

Nonlinear stability combination : SN1
1 [5,77

Nonlinear stability combination : SN2
1 [5,76

Nonlinear stability combination : SN3
1 [3,37

Nonlinear stability combination : SN4
1 [3,37

Nonlinear stabll[lty combination : SN5
1 7,13

Nonlinear stabl?ltv combination : SN6
1 7,11

Nonlinear 5tabl=lty combination : SN7
1 4,50

Nonlinear stability combination : SN8
1 [4,49

For a visualisation of the buckling modes, we can go to Menu bar > Results > 3D deformations and select
the appropriate stability combination. We can clearly see a buckling shape at the location of the opening in
our structure (nonlinear stability combination SN3 is shown below):

g — T
= -

—

This means we must consider this buckling shape in our nonlinear combinations and analysis.
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3.3. Nonlinear analysis
3.3.1.  Global frame imperfection ¢

Inclination functions

The global frame imperfection can be inputted for the whole structure by an imperfection value ¢. This value
can be calculated with the following formula (EN 1993-1-1 art. 5.3.2(3)a):

1
. =—rap-Q
@ 200 h m

+ ay = buti<a, <10

. a, = /0.5-(1+i)

e h: height of the structure in meters
e m: number of columns in a row including only those columns which carry a vertical load Neq not
less than 50% of the average value of the vertical load per column in the plane considered

These inclination functions are entered through Menu bar > Libraries > Structure and analysis > Initial
deformations :

o fa
£ layers
U Materials Ctri+M
I3 Cross sections Ctri+)

B image gallery
Paperspace gallery
Load cases, combinations

Loads

I Structure and analysis | \ Buckling groups

Tools I° Nameditem

Steel [EJ Effective section properties

Subsoil and foundation T Cross section list

vy |lv v w|lwv|¥ «

Drawing tools = Fabricated CSS & product range

18I Orthotropy

|/ Weniinear functions

& Hinge type
Ir:| Initial deformations I

We will create two functions: one for the X direction and one for the Y direction:
e the type is chosen as EN 1993-1-1 art. 5.3.2(3), with a basic imperfection of 1/200;
« the height of the construction is 4 m in X direction (due to anchors each 4m) and 20 m in Y direction;
* there are 12 columns in the X direction, therefore the number of columns in this direction has been
inputted as 12;
* There are 2 columns in the Y direction, therefore the number of columns in this direction has been
inputted as 2;

The inclination function for the X direction (DefX) is displayed below:
Name DefX

Type EN 1993-1-1art. 5.3.2(3) v

Basic imperfection value 200,00
Height of structure: [m] 4,000
Number of columns per 12
®: 0,00368000
a,:[1 1,00
a :[] 0,74
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If you have a structure with an irregular shape, you'll need to enter all nonlinear combinations four times:
once with the inclination according to the positive X direction, once according to the positive Y direction,
once according to the negative X direction and once for the negative Y direction.

In our model we have a scaffolding with anchoring every 4 m. Therefore, we will apply a factor on the
inclination functions DefX and DefY. We consider that the deformation will be zeroat4 m, 8 m, 12 m, 16 m
and 20 m. This results in following function for X direction:

B Initial deformations

A “s O =@ a
DefX
DefY
FunctionX
FunctionY

Mame FunctionX 15
Type Manual input v
4 Defor
1 [m,mm] 0,000 /0,0
2 [m,mm] 2,000 /7,4
3 [m,mm] 2,000 /0,0
4 [m,mm] 6,000/ 22,1
5 [m,mm] 8,000 /0,0
10,000 / 36,8
12,000 /0,0
14,000 [ 51,5
16,000 /0,0 0

& [m,mm]
T [m,mm]

8 [m,mm]

9 [m,mm]

18,000 [ 66,2

20
40
60),

10 [m,mm]
11 [m,mm] 20,000 /0,0

60
40
=20

New Insert Edit Delete

80

Close

We have already created nonlinear combinations NC_CO1-NC_CO08, which we will give as Global

Imperfection GI_X.

We can copy those eight combinations (so NC_CO9-NC_C016 are created) and we change the Global
Imperfection to G1_Y (so with initial deformation Function Y).

Now we have 16 nonlinear combinations:

B | Menlinear combinations *
=) S “ 2 O Al A
INC_CO1 Mame MC_CO1
NC_CO2 Description
NC_CO3 Type Ultimate v
neros Gl X Contents of binati
NC_COS ontents of combination
NC_COE\ LCl-SE‘l‘F-WE‘ight ['] 1,20
NC_COT LC2 - Other permanent load [-] 1,20
NC_COs8 LC4 - Service load max wind [-] 1,50
NC_COs LCS - Max wind X [] 1,50
e ie Bow imperfection MNone hd
NC_CO11
I Global Imperfection GI_X ¥
ne_coz| a1 v
NC_C013
NC_CO14
NC_CO15
NC_CO16
New from combinati...| MNew Insert Edit Delete Close
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With as Global Imperfections (Menu bar > Libraries > Load cases, combinations > Global Imperfections):

B Global Imperfection st
e a < O Al *Y
GI_X Mame GI_X
GLY Description
Type Inclination functions w
Direction Z v

4+ dx inclination ...
Function FunctionX .
Factor [[] 1,00
4 dy inclination ...
Function Nene Yo
4 dz inclination ...

Function MNene

New Insert Edit Delete OK

Stability shape as imperfection

As an alternative to global and local imperfections, we can use a buckling shape as a unique imperfection
(according to path 3 of the EN 1993 diagram). Since we have an important buckling shape around the
opening in our structure, we need to check this situation as well. Therefore, we will copy our first eight
nonlinear combinations NC_CO1-NC_CO8 and apply buckling shape S4 as global imperfection on them.

Since the buckling shape is dimensionless, Eurocode gives a formula to calculate the amplitude ninit of the
imperfection:

Ninie = € Ner n
init — 0% 1 7 "ler
it E- Iy ’ r]cr,max
With:
B _><-(X)2 :
« ep=a-(A—02) SRk __ VM1 for} > 0.2

Nrk  1-x-(A)
. _: NRk
A= NG
a:

imperfection factor for the relevant buckling curve

s X reduction factor for the relevant buckling curve, depending on the relevant cross-section

*  Nrk characteristic resistance to normal force of the critical cross-section, i.e. Npirk

*  Ner elastic critical buckling load

e Mgk characteristic moment resistance of the critical cross-section, i.e. Mel,rk Or Melrk as relevant
* MNer shape of the elastic critical buckling mode

*  n’omax: Maximal second derivative of the elastic critical buckling mode
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Often ninit is taken as L/200. So, for our project we will set a maximum deformation of 20 mm, which
corresponds with L/200 for a height of 4 m (since our buckling shape occurred over a height of 4 m):

B Menlinear combinations

X

EEfEFE «2 O A

v Y

NC_CO1
NC_CO2
NC_CO3
NC_CO4
NC_COS
NC_COs
NC_COT
NC_COs
NC_CO9
NC_CO10
NC_CO11
NC_CO12
NC_CO13
NC_CO14
NC_CO15
NC_CO16
NC_CO17
NC_CO18
NC_CO19
NC_CO20
NC_CO21
NC_CO22
NC_CO23
NC_CO24

a

Mew from combinati..| MNew

Name
Description
Type
Contents of combination
LC1 - Self-weight [-]
LC2 - Other permanent load [-]
LC4 - Service load max wind [-]
LC5 - Max wind X [-]

Bow imperfection

NC_CO17

Ultimate w

1,20
1,20
1,50
1,50

Nene v

I Global Imperfection

GLSN1 v ...

Insert Edit Delete

Close

B Global Imperfection

EEEFE «s

m YT

GILX
GLY

Mame GI_SN1

Description

‘GI_SN1
GI_SN2
GI_SN3
GI_Sha
GI_SNS
GI_SNe

Type Buckling shape
Type of stability Nonlinear
Stability SN1
Eigen shape 1

Max deformation [mm 20,0

GI_SNT
GI_SNg

New Insert Edit

Delete

OK

Annex D described an example where the value for ninit is calculated exactly.
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3.3.2. Initial bow imperfectione o .

The initial bow imperfection eq is given by:

Buckling curve | elastic analysis | plastic analysis
acc. to Table 6.1 ey /L e/ L 0
ag 1/350 1/300
a 1/300 1/250
b 1/250 1/200
c 1/200 1/150
d 1/150 1/100

The buckling curve used for calculation of the imperfection is the curve inputted in the cross-section library.

For standard sections, the curve according to the code is automatically used, for non-standard cross
sections (as general cross sections) you need to input the buckling curve manually.

SCIA Engineer can calculate the bow imperfection according to the code automatically for all needed
members. But in a scaffolding structure all profiles have the same buckling curve and thus the same bow
imperfection. This bow imperfection is inputted as simple curvature : the same curvature for all members:

B Menlinear combinations >

HoEEFE «as O A A2
NC_CO1 Mame NC_CO1

NC_CO2
NC_CO3
NC_CO4

NC_CO5
NC_CO6 LC1 - Self-weight [-] 1,20

Description

Type Ultimate w

4 Contents of combination

NC_COT LC2 - Other permanent load [-] 1,20
NC_CO& LC4 - Service load max wind [-] 1,50
NC_CO9 LC5 - Max wind X [] 1,50
NC_CO10 |
MC_CO11
NC_CO12
MC_CO13
NC_CO14 1/f 200
NC_CO15
MC_CO16
MC_CO17
NC_CO18
MC_CO19
MC_COz0
NC_CO21
NC_C022
MC_COz3
NC_CO24

Bow imperfection Simple curvature v
Global Imperfection GI_X ¥ ...
£ 0,005

Mew from combinati..| MNew Insert Edit Delete Close

Note: for nonlinear combinations NC_CO17-NC_CO24 it is not necessary to activate the bow imperfection,
since the local imperfection is included already in the buckling shape.

Note: in the Netherlands, a guideline for scaffolding structures mentions as value for the global imperfection

tan @ = 0.00157 and as value for the local imperfection L/200.
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3.3.3.  Second order calculation
First, do not forget to turn on the functionality Geometrical nonlinearity in the project settings dialogue to

consider the second order analysis!
The method that we will use for our second order calculation is the so-called Newton-Raphson method

(Th.111.O) for the solution of nonlinear equations.

This method is a more general applicable method which is very solid for most types of problems. It can be
used for very large deformations and rotations, however the limitation of small strains is still applicable.

o |5 ")
e i .
l’l
I”
X ; l. Mr=H.x
! Il. Mr=H.x+Fy
/ IIl. M= H.(x-w) + Fy
- 4M

¥ §

Mathematically, the method is based on a step-by-step augmentation of the load. This incremental method is

Choose AF

illustrated on the following diagram:

F=Fo+AF

Solve K1. Au=F

u=u+ Au

Convergence
inu?
Yes

Determine Fy

In this figure, the tangential stiffness Ky is used. The symbol u depicts the displacements and F is the force

matrix.
The original Newton-Raphson method changes the tangential stiffness in each iteration. There are also
adapted procedures which keep the stiffness constant in certain zones during for example one increment.

SCIA Engineer uses the original method.
As a limitation, the rotation achieved in one increment should not exceed 5°.
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The accuracy of the method can be increased through refinement of the finite element mesh and by
increasing the number of increments. By default, when the Newton-Raphson method is used, the Number of
increments is set to 5 (in the solver setup) and you should set the number of 1D elements to at least 5 in
the mesh setup (we choose already for 5 as average number of tiles of 1D element when we performed the
stability calculation).

In the mesh settings we also advise to deactivate the option Generation of nodes in connections of beam
elements (by default this option is ticked off):

B Mesh setup *

MName MeshSetupl

I Average number of 1D mesh elements on straight 1D members 5 I

Average size of 1D mesh element on curved 10 members [m] ©,200
Average size of 2D mesh element [m] ©,500
Connect members/nodes
Setup for connection of structural entities
4 Advanced mesh settings
4 General mesh settings
Minimal distance between definition peoint and line [m] 2,001
Definition of mesh element size for panels Manual hd
Average size of panel element [m] 1,000
Elastic mesh
Use automatic mesh refinement
4 1D elements
Minimal length of beam element [m] 2,100
Maximal length of beam element [m] 1000,000

Average size of tendons, elements on subsoil, nenlinear seil spring [m] 1,000

I Generation of nodes in connections of beam elements I

Generation of variable eccentricities on members instead of constant ones

@

Division on haunches and arbitrary members
Division for integration strip and 2D-1D upgrade 50

Mesh refinement following the beam type None v

BE'ms .PI 0K Cancel

When this option is activated, beams will be connected by the nodes they are going through. But when 4
nodes are inputted on the beams, it could happen that a node has been inputted in the middle of a diagonal
and another diagonal is crossing this one in the program and now they are connected. To avoid unwanted
connections, we advise to uncheck this option.
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The criterion for convergence is defined as follows:

Y(ud; + ug; + uZ) - Y(ui, + uyig + uZiq)
Z(uﬁ,i +ug; +ug;

< 0,005/(precision ratio)

With:
°*  Uxi displacement in direction x for iteration i
Uy displacement in direction y for iteration i
e Uz displacement in direction z for iteration i

This convergence precision (solver precision ratio) can be adapted in the solver settings (Menu bar > Tools >
Calculation & Mesh > Solver Settings ), together with the choice for the Newton-Raphson method, the
number of increments and the maximal number of iterations. The default value for the maximal number of
iterations is 20, but it can be necessary to increase this value (for example to 50, 100, ...) if there is no
convergence after 20 iterations.

B Solver setup *

MName SolverSetupl
Specify load cases for linear calculation
Specify combinations for nonlinear calculation
Specify global geometrical imperfections for calculation
Specify combinations for linear stability calculation
Specify combinations for nonlinear stability calculation
4 Advanced solver settings
F General
P Effective width of plate ribs

[ MNonlinearity

Geometrical nonlinearity 3rd order {large deformation) v
Method of calculation Newton-Raphson "3
Number of increments 5

Maximum iterations 20

-

Solver precision ratio

-

Solver robustness ratio

F  Initial stress
P Linear stability
F  Monlinear stability

BE'ms 'PI 0K Cancel

In some cases, a high number of increments may even solve problems that tend to a singular solution which
is typical for the analysis of post-critical states. However, in most cases, such a state is characterized by
extreme deformations, which is not interesting for design purposes.

As specified, the Newton-Raphson method can be applied in nearly all cases. It may, however fail in the
vicinity of inflexion points of the loading diagram. To avoid this, a specific method has been implemented in
SCIA Engineer: the Modified Newton-Raphson method.

Also, when the Newton-Raphson method is failing, there is the possibility of the method of Picard. This
method follows the same principles as the default method but will automatically refine the number of
increments when a critical point is reached. This method is used for the nonlinear stability calculation.

44 BV —2024/03/01



Chapter 4: Checks

41. Member check

411. SLS check

The deformation check in SLS (Serviceability Limit State) is a part of Eurocode 3. According to the code EN
12811-1 the allowable deformation for the total deflection is L/100. You can set the limit value via Menu bar

> Design > Steel members > Settings > SLS deflection check (or Menu bar > Design > Aluminium >
Settings > SLS deflection check ):

B Steel setup

[=l- Belgian NBMN-EN MN&
£ Steel

- Member check
- Fire resistance
-~ Cold Formed
- Plated structural elements
= Limit slenderness
-~ Buckling defaults

& 5LS deflection check

- Autodesign

Mame Belgian NEN-EN NA

4 SLS deflection limits
4 In plane deflection (def z)

4 Qut of plane deflection {def y)

4 Steel

P Member check EN 1993-1-1
P Fire resistance EN 1993-1-2
b Cold Formed EN 1993-1-3
P Plated structural elements EN 1993-1-5
P Limit slenderness EN 50341-1
 Buckling defaults

4 5L5 deflection check

Total loads [-] 100.00
Variable loads [-] 100.00

Total loads [-] 100.00
Variable loads [-] 100.00

4 SLS camber

P Autodesign

Load default non-NA parameters

Camber definition Nocamber

Load default MA parameters OK | | Cancel

Choose for Menu bar > Design > Steel members > SLS check (or Aluminium > SLS check in case you
have modelled aluminium elements, this functionality is available in the 64bit version since SCIA Engineer

22.0) and ask the results for the nonlinear class NC_SLS:

Piease cli

EREE
Steel members > 'C‘ Settings
Steel connections > 'l Slenderness
Aluminium > T LS check
Timber » | s Scaffolding coupler check
|l sts check
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The maximum unity check of 0.28 is found for beam B859:

EC-EN 1993 Steel Check SLS
Values: Check overall
Monlinear calculation

Class: NC_SLS

Coordinate system: Principal
Extreme 1D: Global
Selection: All

/

’i

Yo S,

EC-EN 1993 Steel Check SLS

Noninear calculation

Class: NC_SLS

Coordinate system: Principal
Extreme 1D: Global
Selection: Al

Overall Unity Check

Uyyvar LM Uymax LML Uyyar Check Camber dx Checkoveratl
[mm] [mm] [mm] ; ur -1
Uzyvar LML Uzmax LML Uzvar [mm]

[mm ] [mm] [mm ] Camber

[mm]

Or as relative output (available since SCIA Engineer 24.0):

EC-EN 1993 Steel Check SLS

Monlinear calculation

Class: NC_SLS

Coordinate system: Principal
Extreme 1D: Global
Selection: Al

Overall Unity Check rel

Uy,varrel Lim. Lim. Check Camber dx  Check overall
[Thxx] [ Wrmscdd | Wyimresd g " Uzrel [-1
Uzuarest  [1/30¢]  [1/50x] - - [1/>ac]

[1/3x] Lim. Lim. k  Camber,rel

U z,max, rel U zvarrel % llln}
[1/x]  [1/xx]
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41.2. ULS check

The scaffolding check is executed according to equation 9 of EN 12811-1-1 article 10.3.3.2. However, the

EN 12811-1 only gives an interaction equation in case of a low shear force. Since the EN 12811-1 is based
entirely on DIN 4420-1 Teil 1, the interaction formulas according to Table 7 of DIN 4420-1 Teil 1 are applied
in case of a large shear force. The interaction equations are summarised as follows:

Conditions Interaction for tubular member
M
(LSL) and (le) -
Npld 10 Vpid 3 Mpld
M
1 N \%
—<—S1)and<—£— .
(10 Npid Vpld Mpld - COS (%)
M
(Nllds%)and§<%so.9 " . (V)Z
p p -\
pld Vpld
M
1 N 1 \'%
—<—S1)and—<—§0.9 2 m-N
(10 Npid 3 " Vpud Mpld - (V ) cos
pld V \2
2Nyg- |1— (—)
pld 1d
v > 0.9 v
Vp]d ) 09 " Vpld
N -1 N
Npia Npia
With:
« M M2 + M,?
Y /Vyz +V,?
e Q: Wpt <1.25
Wel
Af
. Noid: 2y
pld . f
. . Zoa._y
Vpld. - A N2
e Mpid: cWerly
YM

LRIV safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for

aluminium couplers

Only section checks are executed since the stability effects are considered in the second order calculation
with imperfections and a lateral torsional buckling check is not relevant for tubular profiles. In case these
conditions are not set the default EN 1993-1-1 check will be executed instead.

Choose for Menu bar > Design > Steel members > ULS check (or Menu bar > Design > Aluminium >
ULS check in case you have modelled aluminium elements) and ask the results for the nonlinear class

NC_ULS:

Steel members

Steel connections
Aluminium

Timber

¥ © o ‘a

4 i Settings
L4 i?. slenderness

b [T uLs check

» #, Scaffolding coupler check

Ak SLScheck
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In the properties window you can choose for Brief, Summary or Detailed as output type:

»  Brief output: the results are shown in one line;

» Summary output: the results of all the individual unity checks are shown;

» Detailed output: the results of all the individual unity checks are shown. Since SCIA Engineer 19.0
also each individual formula can be shown. You can choose to print only the tables, only the

formulas or both.

The maximum unity check of 0.60 is found for beam B859:
EC-EN 1993 Steel check ULS

Values: UC overall
MNeonlinear calculation
Class: NC_ULS

Coordinate system: Principal

Extreme 1D: Global
Selection: All

Y | - =~
i _'I I .II I|
lr_'——'\ll: b= == | J
b s AN AT ]
21 o _-"-:. :_-._1, ._I.
| i : I =
A \ ! I: Ly .r 1!'. I &
=1 % 1 § 0N H ¥
| |
- T 7 4. 1 | (T e
I b A [ e N
; 5, ! = ! ; | TIEE A
EC-EN 1993 Steel check ULS
Values: UCoverall
Nonlinear calculation
Class: NC_ULS
Coordinate system: Principal
Extreme 1D: Global
Selection: Al
EN 1993-1-1 Code Check
EN 12811-1 Scaffolding Check
National annex: Belgian NBN-EN NA
Member B859 |0,545/ 1,090 m |R0O48.3X3.2 |Rolled (S235(ReH= [NC_ULS |0,60 -
320 N/mm2 )
LM m M =
NC_ULS / NC_CO12
Partial safety factors
Resistance of cross-sections  |ymo |1,10
Resistance to instability yme 1,10
Resistance of net sections ymz [1,25
Yield strength f, [320,0 |MPa
Ulimate strength [fu [360,0 |MPa

The critical check is on position 0,545 m

Internal forces Calculated Unit

Normal force Ned 0,19 kN
Shear force Vyed [-0,01 kN
Shear force Veed |-1,43 kN
Torsion Ted 0,00 kNm
Bending moment  |My.ed [1,05 kNm
Bending moment  |Mzeq | 0,00 kNm
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Scaffolding check for tubular members
According to EN 12811-1 & DIN 4420 Teil 1 article

5.4.7.4 and table 7

Normal force resistance

Nps [131,78 [kN

Shear resistance

Vpld  [48,44 kN

Bending resistance

Mpta [1,75 kNm

Unity check N 0,00 -
Unity check V 0,03 -
Unity check M 0,60 -
Unity check Interaction 0,60 -
Unity check Max 0,60 -

aly

Wi . {6,5088 10 %[m’
o = min (W‘—" I.25) = min ()7{'"]

% b
4,8000 - 10 °[m’|

25) =min(1,36;1,25) = 1,25

v K300 m?] % 320. =
Ny — Axf 4530010 [m?] « 320, 0[MPa] 131, 78KN]
ThMo 1,10
5
A x f_T 54,5300 107[m?] x L[';P‘] 5
A L' b A pa 2
Vot = = TTo < - 8, 44[kN]
2
Mt = gt X Wety % = = 1,25 x 4,8000 - 10-5[m?] x 22 llMPa] _ ; 251vm)
" e 1,10
; |Ngy| 0, 19[kN]|
Jnity check N —_—— L00 <1,
Unity chee Nyo 131, 78kN] 0,00 < 1,00
. V esuitant 1_‘13{5{[\]]
il <
Unity check V Va <0.0  28.44kN] % 0,0 0,03 < 1,00
. M guuitant 1, 05[kNm|
“heck M - —_— L60 < 1,
Unity chec Mo s 1. 75[kNm] 0,60 < 1,00

Unity check Interaction = Unity check M = 0,60 < 1,00

Unity check = max (Unity check Interaction; Unity check N; Unity check V; Unity check M) = max (0.60;0.00;0,03,0.60) = 0,60 < 1,00

The member satisfies the section check.

SCIA Engineer will show you directly the scaffolding check, when choosing for the Eurocode check for
circular hollow sections, because we have activated the Scaffolding functionality in the beginning of the

project. If you do not want to see the scaffolding check, but the general Eurocode check (EN 1993-1-1), you
can uncheck this option in the steel settings :

B " Steel setup

(- Steel

[=)- Belgian NBMN-EN M4

Member check

Fire resistance

Cold Formed

Plated structural elements
Limit slenderness
Buckling defaults

i 515 deflection check
5----Autodesign

4 Steel
4 Member check
Classification
Shear
Torsion
Default sway types
Buckling length ratios ky, kz

Lateral Torsional Buckling

NS T VNN W

General settings

Name Belgian NBN

EN 1993-1-1
EN 1993-1-1:
EN 1993-1-1:
EN 1993-1-1:
EN 1993-1-1:
EN 1993-1-1:
EN 1993-1-1:

-EN NA

X

5.2.2
6.2.6
6.2.7
6.3.1
6.3.1
6.3.2

4 Scaffoldin
| Apply scaffolding check for CHS and numerical secticns no

Apply Interaction 3 check for scaffolding couplers @ yes

Fire resistance

Cold Formed

Plated structural elements
Limit slenderness
Buckling defaults

SLS deflection check

¥ v vV v v v v

Autodesign

Load default non-NA parameters

EN 1993-1-2
EN 1993-1-3
EN 1993-15
EN 50341-1

| Referencet EN 12811-1 article 10.3.3.2, DIN 4420-1 Teil 1 Tabelle 7
| Description: Setting to apply the scaffolding check for Circular Hollow Sections and numerical sections.
i}\pplicaijon: When this setting is activated, a specific interaction check is executed for scaffolding sections
| instead of the regular EN 1993-1-1 code check.

Load default NA parameters

| This section check should be used in conjunction with a 2nd Order analysis including imperfections.

e

A

You can find the same option in the Aluminium Settings

you want to follow EN 1999-1-1 instead of the specific scaffolding check.
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4.2. Coupler check

When checking the allowable stresses, it is recommended to view the results per profile type (standards,
bracings, ...). The maximal stresses can now be compared to the allowable values of the supplier. Also the
base jacks are checked with this value.

For the anchorage forces, the reaction force can be tested to the allowable force of a perpendicular coupler.
On the other hand, the anchorage can also be checked manually on the combined effect of tension and
shear.

For the couplers, this check can be performed by SCIA Engineer itself, with the option Menu bar > Design >
Steel members > Scaffolding coupler check  (or Menu bar > Design > Aluminium > Scaffolding coupler
check for aluminium couplers).

This check performs a unity check for the couplers for which a maximal allowable force is given in the
coupler library:

B Hinge type library x

EAREE a2 O AwB A L

K2000+

ux Rigid v
uy Flexible w
Stiff - uy [MN/m] 4.8500e+00
uz Rigid v
fix Monlinear o
SHiff - fix [MMm/rad] 1.38T6e-03
Fun - fix Layher K2000+ -Mx ¥ .
fiy Monlinear v
Stiff - fiy [MMm/rad] 7.6630e-02 5
Fun - fiy Layher K2000+ - My Vo |

fiz Flexible v \:;; ] N | —
-
SHFf - fiz [MNm/rad] 5.1000e-03 [ IF

Hinge type Layher (Variante K2000+)
Material Steel b
Picture
Mxk [kN] 34.10
Wk [kN] 11.00
Vzk [kN] 29.04

Mk [kMm] ©.58

Myl [kMm] 1.11

Mzk [kMm] 0.41

Mew Insert Edit Cloze
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4.21. General couplers

Following table provides an overview of the performed component checks for each type:

M. | Interaction
Right angle W 4 Y4
Friction sleeve - -

Swivel - -
Base jack A -
Parallel - -
General 4 -

For a right angle coupler the interaction formula is:

N+V, W My INgal + [Vogal | [Vyedl My kdl
— 4y = + + <1
For o Fpx (M Nyk + Vik Vyx My i
2.-sk  Ipk 5y vk g Sk
Ym Y™ Y™ Y™ YMm Ym

For a friction sleeve coupler the formula is:
N M, _
5. Fsk Mpk o, Nxk o Myk
Y™m Y™m

1

_ INgql +|My,Ed|S

Ym Ym

o Fsk characteristic slipping force, taken as Nxk and V. of the coupler properties: 2Fsk=Nxk+Vzk
e Fpk characteristic pull-apart force, taken as Vyk of the coupler properties

e Ms: characteristic bending moment, taken as My of the coupler properties
« N normal force

e Vy shear force in y direction

e Vz shear force in z direction

e My bending moment about the y axis

°* YM: safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ymt1 of EN 1999-1-1 for
aluminium couplers
e Nxk, Vyk Vzk, Myk: coupler resistances given by EN 12811-1 Table C1

Loads on a coupler are defined by following figures (left below is a right angle coupler and right below is a
friction type sleeve coupler), see also Annex A:
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4.2.2.  Manufacturer couplers

In addition to the list of general couplers, following table provides an overview of the performed component
checks for each type of manufacturer coupler:

Cuplok
Layher K2000+

Layher Variante Il
Layher LW
Catari US

Notes:
e The Catari US coupler type and the interaction 3 check are available since SCIA 20.
» Since SCIA21.1 it is possible to turn off the interaction 3 check via the steel settings.

Cuplock

The Cuplock coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-
208:2022. The interaction equations are:

Interaction 1:

N M M N M M
+ y+ x:|Ed|+|y,Ed|+|x,Ed|S1
Nk Myx Mgk Ngk My x Mk
Y™m Y Y™ YMm Ym Y™m
With:
 N: slipping force, taken as normal force in the ledger
o My bending moment about the y axis
o Mk torsional moment around the x axis

LRIV safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for
aluminium couplers
*  Nxk, Myk, Mxk: coupler resistances given by Z-8.22-208:2017 Table 4

Interaction 2:

My, (N+N,- sin(a)) |MyEd| [NEq + Ny kg - sin(a)| N M, 4] <1
My k Nk My Nk Mgk ™
Y Ym M YMm YMm Y™
With:

« N: slipping force, taken as normal force in the ledger

o My bending moment about the y axis

o Mx torsional moment around the x axis

e Nu normal force in a connecting vertical diagonal

* ywm safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for
aluminium couplers

e angle between connecting vertical diagonal and standard

*  Nxk, Myk, Mxk: coupler resistances given by Z-8.22-208:2017 Table 4
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Interaction 3:

lo+0.7 Iy == +0.7-1 Vmg°t+n‘§‘°t+07 <1
S Srla=oT U/ =T ——— T U/ A s
b [m? + n2
With:
o A My utilization of connected coupler
o ls: in-plane utilization of column (the definition of lengths a and b are given by article 3.3.2.2
build 1)
e a initial length
e b projected length
* mact: actual utilization of in-plane bending moment in column section = “\]\:“—Ed'
st,Rd

* Msteda: design bending moment in column section adjacent to the coupler

. . . op)'Welf w,
«  Mstra:  bending moment resistance of the column cross-section = -2 —13% ang Ap = Pl <125
el
- . . . N
*  Nact: actual utilization of normal force in column section = |N“—'Ed|
st,Rd
* Nsea: design normal force in column section adjacent to the coupler
. . Astf,
« Nsira:  normal force resistance of column cross-section = —=-Y&
M
e m: value of bending moment utilization when combined UC is equal to 1 (the smallest positive
root of the cubic function)
e n corresponding value of normal force utilization calculated from current curve function
— (nact) ‘m
Mact
o Ast cross-section area of column cross-section
* Wweppl: elastic / plastic section modulus of column cross-section
*  Vact actual utilization of vertical in-plane shear in column section = Vstal
st,Rd
* Vstea: design shear force in column section adjacent to the coupler
. . . _ Av,st'fyk
* Vsrd: shear force resistance of column cross-section = v
‘YM

* ywm safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for
aluminium couplers

Column internal forces are selected considering the possible rotation of the column. If the angle between the
connected beam LCS and column LCS is smaller than 45 deg, then:

. Msted = My,st,Ed, else Mz,sted

. Vsted = Vy,stEd, else Vz,stEd

Also, in certain geometries there can be two sections to choose from. In this case the selection is based on
Von Mises stress calculation. The section which will result in larger stress will be used for the further
calculation of Is. The stress will be calculated as indicated below:

2 2
N M V.
6= \/Ggot,Ed +3- 1, = \/(O'N +oum)2+3 15 = \/<| :\t'Ed| + |VvStEd|> +3- (—l ;t'Ed|>
st el,st v,st

The bending moment utilization of column m, may be calculated by solving a derived cubic function, using
coefficients Ci1 and Cz depending on the shear force utilization of column section Vact:
Cz'm3+4'C1'C2'm2+4'm—4'C1 =0

With:
1
« Cu for vaee < 3 C;=1
1 _ 2
fOI’ g S Vact S 0.9: Cl = 1 - Vact
1 n
« Cux forvye <-:C, = =2¢
1act 3 2 Mact
. _ Dact | 2
for 3 Vot £09:C, = a V1= Vi
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Special cases are:
d Mact £ 0.0001 2 Is = Nact
. Nact = 0 2 Is = Mact
. Mact < 0.0001 and if Nact =0 > Is =0

For the case when 0.9 < vact an error will be displayed and UC_Interaction 3 will be set to 999.

To recognize a member as a column, the type of the member has to be either ‘column ’, ‘gable column ’ or
‘secondary column ' and the cross-section has to be Formcode 3 (CHS). In case two columns are found,
both need to be within one buckling system. If the above is not fulfilled or if there are more column members
found, the column geometry is not recognized and the unity check is set to 999. See also following chapter.

Layher

The Layher coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-64:2022
for Variante 1l and Variante K2000+ and in Zulassung Nr. Z-8.22-939:2022 for Variante LW.

Interaction 1, Variante Il:

ND LMy max(V,-1450 VN My £l max(|VzEd| V,,Edmin 5 0) N M, g | yeal _ <1
Nra  MyRrad My 25.0  Nyx M Vak M Vde
Ym Ym Ym Ym

Interaction 1, Variante K2000+:

N® M,  max(V,—-21;0) My
+ + =1
Nra  Mygrg My 27 1 MT,R,cl
|My,Ed| max(lszd| zEd min 7 ) + |MZ,Ed| + |Vy,Ed| + |Mx,Ed| <1
Nk M Vi My Vyra  Mxk
YM Y™ YM YMm YM

Interaction 1, Variante LW:

NG |M | +max(|VZ| —-25;0) M, vy | Mr _ .
Ngrgq Mde V.rd |MZ,R_d| | R_d| MrRra ~
|My,Ed| max(lszd| zEd min 7 ) |MZ,Ed| |Vy,Ed| + |Mx,Ed| <1
Nyk M Vi Mgk Vy ra My —
Y™m Ym Y™m Ym Y™m

Note: an additional check for welds is not supported.

With
 N: slipping force, taken as normal force in the ledger
o (+): this index indicates a tensile force (=0)
e Vy shear force in y direction
o Vz shear force in z direction
o My bending moment about the y axis
e My torsional moment around the x axis
s Mz torsional moment around the z axis

°*yMm: safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for
aluminium couplers
e a angle between connecting vertical diagonal and standard
e Nxk, Myk, Mzx, Mxk, Vyk, Vzk: coupler resistances given by Z-8.22-64:2018 Table 5 for Variante Il and
Variante K2000+ en Z-8.22-939:2022 Table 5 for Variante LW
*  Vzedamin: 1.4 kN for Variante I, 2.1 kN for Variante K2000+ and 2.5 kN for Variante LW
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Interaction 2:

Ledger:

(n® +nB)2 + (vA +vB)2 <1

Ledger A / Vertical diagonal B

NAIYME | /e
= i £

E N g |

i ep
0,707sin a N;? + | == |.cos a|Ny |
n - 5
ENg4 |

v

¥ Vx R,d

€05 iz Ny
v v

=R d

NEd | y Ed |

Nx,k
5 Y™m

nA =

0.707 - sin (@) * Ny gq + =D cos (@) - |NvEd|

Nx,k
g Y™m

nB =

Vertical diagonal:

With
« N
© ()
M Nv:
i My:
. Vz.
¢ ym
. a:

VZ,Ed

Vi

Y™m

cos (a) * Ny gq
Vak

YMm

VA =

slipping force, taken as normal force in the ledger

this index indicates a tensile force (=0)

normal force in a connecting vertical diagonal

bending moment about the y axis

shear force in z direction

safety factor, taken as ymo of EN 1993-1-1 for steel couplers or ym1 of EN 1999-1-1 for
aluminium couplers

angle between connecting vertical diagonal and standard

*  Nxk, Vzk: coupler resistances given by Z-8.22-64:2018 Table 5 for Variante Il and Variante K2000+
en Z-8.22-939:2022 Table 5 for Variante LW

d e:
. ep:
. g:

2.75 cm for Variante |1, 3.30 cm for Variante K2000+ and 3.30 kN for Variante LW
57cm
1.26 cm for Variante Il, 1.85 cm for Variante K2000+ and 1.85 kN for Variante LW
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Interaction 3, Variante |l:

|Nst,Ed | + |Mst,Ed |

o A W,
Ig+0.148 1, = —~+0.148 -1, = —= bt 10.148-1, <1
fya fyq
With:
e A My utilization of connected coupler
o ls: in-plane utilization of column

* Nstea: design normal force in column section adjacent to the coupler

* Mstea: design bending moment in column section adjacent to the coupler
e Ast cross-section area of column cross-section

*  Waest: elastic section modulus of column cross-section

Interaction 3, Variante K2000+ (given by Z-8.22-64 Table 6):
I[s+0316-1, <1

The calculation routine is similar as the one described for Cuplok coupler.

Interaction 3, Variante LW (given by Z-8.22-939):
Is+0.170-1, <1

The calculation routine is similar as the one described for Cuplok coupler.

Catari US

The resistances and stiffness function of Catari Universal System (US) coupler are given by AENOR Product
Certificate A34/000035. The reference only provides normal force resistance for tension.
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4.2.3. Interaction 3 check

Interaction 3 is a special failure mode where the coupler punches into the standard. This failure type thus
occurs only for modular systems (Layher & Cuplock) where the ledgers are connected to the standard.

In order to recognize the member as column, the type of the member has to be either "column (100)", "gable
column (70)" or "secondary column(60)" and the cross-section has to be Formcode 3 (Circular Hollow
Section). For the ledgers the type "beam (80)" is available and for diagonals types "wall bracing (0)" and

"roof bracing (0)" are available.

B Column %
| Name B1 “
jz l Type calumn (100} A
ey\ Analysts modelfgeneral (0]
Cross-section h?a'“ :soll -
@ Alpha [deg]fgable column (70}

Member system.line at|econdary column [60)
rafter [80)
ey [mmllortin o)
ez [mm] | roaf bracing (0]
Lcsfwall bracing 0]

R rt i)
LCS Rotation [deglftruss chord (95)

FEM typetruss ciagonal (90]
beam clab [00)
Layer e

i
J @ 4 Buckling
-.'/ f Sysbem lengths and buckling settings Default
Secondary member
4 Geometry
Length [m] 2,000

ettt Rabbam -

oK y Cancel

In case two columns are found, both need to be within one buckling system:
» the Local Coordinate System (LCS) should be the same for both columns
» the columns should be modelled correctly, i.e. in 1 vertical line. Avoid inaccuracies, even if it's less
than 1 mm (pay attention when importing the structure from other software).
« The orientation of the elements should be equal

e

If the above conditions are not fulfilled or if there are more column members found, the column geometry is
not recognized and the unity check is set to 999.
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Also pay attention when you have a transversal bar, or diagonal, attached to a continuous standard where
also a continuous ledger passes.

Vs

i W

4
r |
a
. & 5
‘ ki

‘ »

m

As for the image below, there is an error for the interaction 3 unity check, which states that the geometry is
incorrect ("No valid column (standard) geometry was found. Please revise the geometry").

AEPOET PREAEW BEOSkE =] ]]E!_Q il — *

Scaffolding - Coupler check
Lerwar Eblnt o
imad - LCL
[ s A R )
Pzera 13 Lethan
=] Samtid W1

Lrror 131 o wwll osdeen {siesdamd) geomsslry mes bl Fiases reves Uis geossiry
I3 Safbokting - Lomger (ki
B
-

v I

H ot . D WO MGy D
11

This is because on the right side, the element B9 has been connected to the ledger, and not to the standard.

This failure mode does not occur for crossing members (cross-links) since there the ledger is continuous and
thus does not cause punching in the standard.
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4.2.4. Coupler check

Choose for Menu bar > Design > Steel members > Scaffolding coupler check

Aluminium Scaffolding coupler check
for the nonlinear class NC_ULS:

¥ © o ‘a

Steel members

Steel connections
Aluminium

Timber

v

"5:E Settings
':\ Slenderness
. f“]' ULS check

Please ¢l

I &y Scaffolding coupler check

£k SLS check

The maximum unity ch

i

- Scaffolding oupler ch
Values: UC 1
Nonlinear caléufatio
Class: NC_Uk 4'“
Coordinate P Principhiy

Extreme 1D: “ﬂ.
Selection: Al !k

g
|

5

!

g

{
r!

Scaffolding - Coupler check

Nonlinear calculation

Class: NC_ULS

Coordinate system: Principal
Extreme 1D: Global

Selection: Al

Scaffolding - Coupler Check

Name dx Case UCHax UCrx UCry UCk:

[m] []

[] []
$5919 [5,140 |NC CO4 | 0,62] 0,49] 0,00

UCmx

[]
0,00

(1] My
[] [-]
0,09

"-—_.,'
o, g
- Tt ———————

2SR A‘v

UCwmz  UC interaction1

[]
0,00 0,62

UC 1nteraction2

[-]

0,11

(or Menu bar > Design >
in case you have modelled aluminium elements) and ask the results

INININININ

UC 1nteraction3

0,18

BV —2024/03/01

59



Advanced Package Training — Scaffolding

A detailed output including formulas is available since SCIA Engineer 20:

Scaffolding - Coupler check

Nonlinear calculation

Class: NC_ULS

Coordinate system: Principal
Extreme 1D: Global
Selection: Al

EN 12811-1 Code Check
National annex: Belgian NBN-EN NA

Scaffolding Member Location / Length |Material

Coupler [m]

Coupler type

H1300 55919 5,140/5,140 Steel Layher (Variante [NC_ULS |0,62
K2000+)
Partial safety factors
Ymo 1,10
Design internal forces
Member Scaffolding Coupler nit

Normal force Ned 15,06 15,06 kM
| Shear force Vyed 10,03 0,03 kN
| Shear force Veed  |3,06 3,06 kN
Torsion moment | M.es |0,00 0,00 kMNm
Bending moment | My.ed |0,09 0,09 kNm
Torsion moment  |Mzed  [0,00 0,00 kNm
Scaffolding coupler resistances
According to Z-8.22-64:2022 Table 5
Scaffolding Coupler H1300
Nk 34,10 kN
Wk 11,00 kN
Vik 29,04 kN
Mk 0,58 kNm
Myk 1,11 kINm
Mak 0,41 kINm
Scaffolding coupler check
According to EN 12811-1
Normal force check N

[Neol  [15. 06[kN]|
Uk =T — 32,7000 — 221,90

o 1,10
Shear force check Vy
UCFy’ |Vy’.Ed| |0'04[kN]| ﬂ, 00 S 1, 00

Vi 11, 00[kN]
o 1,10

Shear force check Vz
_ Magdl 3. 12[kN]|

UCk, —v_ﬂ——m]-=n,lzgl,nn

Mo 1,10
Torsional moment check Mx
[M, gl |0, 00[kNm]|

UGy, — kel = B LEEM g g0 < 1,00

Mo 0, 58[kNm|
M0 1,10

Bending moment check My

M, gl |0, 09[kNm]|
_},_Hk 1. 11[kNm
Mo 1,10

UCy,

Torsional moment check Mz

0,09 < 1,00

M, gql |0, 00(kNm]|
UG, —& D A1kNm] 0,00 < 1,00
Mo 1,10
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Interaction checks
According to Z-8.22-64:2022

Interaction check 1

l:l;d B IM, edl n max (Vo el — Vagamni 0) 1 L n [V, el B M, el

Uclnnsm[tlonl N M, Vi & Vy.Rd M.
Mo Mo T o Mo

_ 15.06[kN] _ [0,09(kNm)|  max (|3, 06[kN]| — 2. 10(kN]: O[kN])  [0,00[kNm]|  [0.03[kN]| [0, 00[kNm]| o ¢ 4 o0
= 34.10(kN] T, T1[kNm] | 29, 0A[kN] ' 0.4TkNm] | 27,100N] | 0,58[Nm]  to- =

1,10 1,10 1,10 1,10 1,10
Interaction check 2

Myed 15, oppin) + 2 2olkNml

A Neg + =T ¥ 33[mm] 0.31

e Ne 185<34'10[kN] o

> g ' 1,10

nB = 0,00

Ve 3.06[kN]
B T ) ) e

gl 1,10
vB = 0,00
UCoractionz = (nA 4+ nBY* - (wA +vBY — (0,314 0,00)* + (0,12 4 0,00)" ~ 0,11 < 1,00

Interaction check 3

Member |B116
Section 2,000 |m
Nated 1432 _|kN
|Vated -0,78  |kN
Msted -0,10  [kNm
As 453 mm?
Avst 288 mm?
Watst 4800 mm?
Wit 6509 mm?

ik 320,0  |MPa
M,eql 10, 00[kNm]|
LT P U VY 7 ) B
o 1,10
&
Nugra Ay %y 453[mm7] x 320, 0[MPa] 131, 78]KN]
Mo Lig
INgeal  |-14,32(kN]|
Mt = Nope  T3T760RN] O
Ay % fu 288[mm?] x 320, 0[MPal
Vi . 48, 44[kN
B Xm0 V/3.00 % 1,10 (kN)
[Vieal [0, 78[kN]|
A Vsl 1 ) ARG
. Wit ) ) (ﬁSOQ[mml] ) ) )
gl = EsiLes ) = 1,25 | = 36;1.25) = 1.
= mun( PLi1,25 ) = min 3800(mm] 1.25 ) = min (1.36;1.25) = 1.25
oy < W % fy 1,25 % 4800[mm’] < 320, 0[MPa]
My e - 110 1, 75[kNm]
|M!IE[||_ | 0<10[kNm]|
Mot = Fons — 1,750Nm] 0
m = 0,41
= L xm = gog X 0.41=0,73

.'_
a=y/mi, +nd, = /0,06200 1 D, 11200 = 0,12

ack

b= v/m? +n? = /0,410 10,7320 = 0,84

UG teractions = ls + 0,316 % 14 = 0.15+ 032 x 0.08 = 0,18 < 1,00
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Chapter 5: Reporting |

5.1. Engineering report

As for other structural projects you can create an engineering report with the structural elements (nodes,
elements, supports, ...), loads (load cases, combinations, ...) and results (displacements, internal forces, ...).

The scaffolding checks (member check and coupler check) can be added as well:

+FETLEER
| SCIiAENGINEER =

Author BV

[:] Header / Footer
E Page format
Table of contents

. (- Special items Date 02.07.2020
7= Page break - External items Project  Scaffolding training
v ) Modelling (Chapter) (- SCIA Design Forms (standalone)
A - 5 Inbox
i [] Analysis model (Picture in scale) - Project 4.2. EC-EN 1993 Steel check ULS
. Nodes - - Libraries Noninear calaation
& & Sets Class: NC_ULS
-—ﬂ Members - & Coordinate system: Principal
e - Solver and Mesh Extreme 1D: Cross-section
-~ Load panels - - Structure Selection: Al
..... B Hinges - (- Load EN 1993-1-1 Code Check
... B Beam nonlinearity - G- Damping EN 12811-1 Scaffolding Check
= #)- Construction stages National annex: Belgian NBN-EN NA
"""" Bl Noomizupoors = (p: Resdls Yo and oldes [MemberB115 [2.00072.000 m [R0483X3:2 [5235 yield320 [NC ULS [038 ]
...... == Page break (8- Solver Files
¥)- Special Combination key
[NC_ULS /NC CO20 |
v ) Loads (Chapter) - Results NC_ULS /NC_CO20
w5 Load cases - - Steel Pal safetyfactors —
1
b [} Picture (icture in scale) P ey
H - Structural joint - overall check [ysc for resistance of net sections |

- £, Page break
~@ Combinations

------ E Page break

Corrugated web beam check
Cellular beam checks

L}

EC-EN 1993 Steel Check ULS
EC-EN 1993 Steel Check SLS
Hollow section joint check

- Aluminium

EC-EN 1999 Aluminium Check ULS
Relative deformation
Slenderness data

Scaffolding - coupler check

L)

—ﬁ Nonlinear combinations
«2SECTION CHECK::...

—E Page break iti & iti
The critical check s on position 2.000 m

... B Stability combinations
—-E Page break
v ) Results (Chapter)

L}

- " . o
v:v Stability combinations - e T
L [_‘f 3D displacement; U_total (Picture in scale) Pipeline Sending
= page break Timber Scaffolding check for tubular members
Concrete According to EN 12811-1:2003 artide 10.3.3.2and equation 9

... EC-EN 1993 Steel check ULS

L3}

000000000000000000000000000006000

Concrete data

= 3178 [N
- »— Page break Concrete Advanced 25.44 [N
Steel concrete bridge 5 KNm
- ol Tl :
M EC-EN 1993 Steel Check SLS - Geotechnlcs 1 =
¥ Scaffolding - Coupler check - Composite Column -
Composite 38
[#- Mobile loads .38

Infl [
ks Influence lies: The member satisfies the section check.
- Integrated Design Forms

Special EN 1993-1-1 Code Check
Gallery pictures EN 12811-1 Scaffolding Check
National annex: Belgian NBN-EN NA

(- Report templates
[MemberB859 [0.545/ 1.090 m [RO48.3X3.2 [S 235 yield320 [NC _ULS [0.60 - ]

5.2. Pictures

It is possible to generate pictures/views based on the line grid. In that case there should be a 3D line grid in
your model. You can right-click in the graphical scene, select Image wizard and choose Sections by planes
of linegrid (overview drawings)

These pictures can be added to the Engineering report as well.
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Annex A: Characteristic values of the resistances f

or couplers
The tables and figures below are taken from EN 12811-1.

Table C.1 — Characteristic values of resistances for couplers

i Characteristic value
Coupler type Resistance
class A | classB class AA | class BB
Slipping force Fg ik in kN 10,0 15,0 15,0 250
Cruciform bending moment
: --- 0,8 —_ —
Mg k in kNm
Right-angle coupler
(RA) Pull-apat  force  Fok| ogp 30,0 - =
in kN
Rotational moment My fe 013 o -
in kNm '
Slipping force Fg i in kN 6,0 9,0 . ey
Friction type sleeve s b
coupler (SF) Bending moment Ms x . 24 e s
in kNm i
Swivel coupler (SW) | Slipping force Fg i in kN 10,0 15,0 - -
f::)’"e' coupler | sgpping force Fs xin kN 100 15,0 - —
For symbols see Figures C.3and C4

My
My,

Key

M; is the cruciform bending moment (kNm/rad);
¢ is the angle of rotation (rad);
" Cg1,Cq2 are the cruciform stiffnesses ;

Mo /ey
¥

Figure C.1 — Mz-9 relationship for class B right angle couplers
My

Key
MH

M: is the rotational moment (kNm)
0 is the angle of rotation (rad)
o ¢, is the rotational rigidity

3

Figure C.2 — M;-o relationship for class B and C right angle couplers secured by screwed means
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Table C.2 — Design values cg, and c, of cruciform stiffnesses
for class B right angle couplers attached to steel- and aluminium tubes

Steel Tube Aluminium tube
Co1 M, Coz Mgz Ces Mg, Ca2 Ms;
[kNm/rad] | [kNm] |KkNm/rad]| [kNm] |[kNm/rad]| [kNm] |[kNnvrad]| [kNm]
15,0 0,48 6,0 08 13,0 0,48 50 0,8
For symbols see Figure C.1

Table C.3 — Design values c, of rotational stiffness
for class B right angle couplers

Co Me;
[kNm/rad] [kNm]
75 0.13
For symbols see Figure C.2

Foa

Key

tube 1

tube 2

slipping force

pull apart force

cruciform bending moment
rotational moment

—“WT 0N -

Figure C.3 - Loads on a right-angle coupler

Key

tube 1

tube 2

slipping force
bending moment

PR

Figure C.4 - Loads on a friction type sleeve coupler
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Annex B: Service loads according to EN 12811-1

The service loads are considered in table 3 of EN 12811-1:

Table 3 — Service loads on working areas (see also 6.2.2)

Load Uniformly Concentrated load Concentrated Partial area load
class distributed on area load on area
load 500 mm x 500 mm | 200 mm x 200 mm gz Partial area
i F F. kN/m? factor
kN/m® kN kN )
P
1 0757 1,50 1.00
2 1,50 1,50 1,00 - ---
3 2,00 1,50 1,00 - --
4 3,00 3,00 1,00 5,00 04
5 4,50 3,00 1,00 7,50 04
6 6,00 3,00 1,00 10,00 05

Uniformly distributed service load g 1 (EN 12811-1, 6.2.2.2)

Each working area is capable of supporting the uniformly distributed loads, g: as specified in the table above.

Concentrated load F 1 and F» (EN 12811-1, 6.2.2.3)

Each platform unit is capable of supporting the load F; uniformly distributed over an area of 500 mm x 500
mm and, but not simultaneously, F, uniformly distributed over an area of 200 mm x 200 mm.

The position of each load is chosen to give the most unfavourable effect.

When a platform unit is less than 500 mm wide, the load may be reduced for this unit in proportion to its
width, except that in no case shall the loading be reduced to less than 1.5 kN.

Partial area load q 2 (EN 12811-1, 6.2.2.4)

This load has to be applied only for classes 4, 5 and 6. In those cases each platform is capable of supporting
a partial area loading g2 on an area Ag:

qu =1'W'ap

With:
o | length
e W width
LI T coefficient of table 3
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The dimensions and position of the partial area are chosen to give the most unfavourable effect. One
example is shown below:

66

M max; 8: max V max
!

x| arx |

Rita Bata & -
| 7 7z [ . =] =

& € -5 >

x| axl
b’SaPXW: o =1

1 n"
apwab Sw: a=a,xX—

br
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Annex C: Wind loads

Since the arithmetic method for the calculation of a wind load from code EN 12811-1 is not valid for all

scaffoldings, provided by nets that completely surround the construction, the code EN 1991-1-4 is adopted.

There are three cases for calculating a reference height (EN 1991-1-4, figure 7.4):

building  reference shape of profile
face height of velocity pressure
b
z:=h 9p(2)=0,(2,)
h< b { T T
T V4
b
e
R —
T2 g
b<h<2b| , o o
b
T zZ
b
>
3 =h
i 1 9p(2)=a5()
b
h hsm;{ TZE:Zsmp qp(z):qp(zsmp) %—"
= @m0
b
T z

In the example discussed in this course, the height is 20 m and the building face is 29.84 m. So in this case

clearly 20 m < 29.84 m and thus h < b. So the wind only has to be calculated for ze= 20 m.

In this example, the wind is calculated for a construction without 50% nets, situated in Belgium for terrain

category IV, wind zone 25 m/s and reference period 15 years.

The terrain category is determined as follows (EN 1991-1-4, Table 4.1):

and their average height exceeds 15 m

. Zo Zmin
Terrain category
m m
0 Sea or coastal area exposed to the open sea 0,003 1
I Lakes or flat and horizontal area with negligible vegetation and
. 0,01 1
without obstacles
Il Area with low vegetation such as grass and isolated obstacles 0.05 5
(trees, buildings) with separations of at least 20 obstacle heights '
Il Area with regular cover of vegetation or buildings or with isolated
obstacles with separations of maximum 20 obstacle heights (such 0,3 5
as villages, suburban terrain, permanent forest)
IV Areain which at least 15 % of the surface is covered with buildings 10 10

BV —2024/03/01
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For Belgium, vpo equals 25 m/s following the EC-EN. In addition cdir and Cseason are all equal to 1.0. From this
the basic wind velocity vo can be calculated with formula (4.1) of EN 1991-1-4:
Vi = Cgir * Cseason * Vb0 * Cprob = 1.0+ 1.0+ 25-0.928 = 23.21 m/s

*  Cair directional factor: value may be given in the National Annex, recommended value 1.0
*  Ceason Se€ason factor: value may be given in the National Annex, recommended value 1.0
. _ (1-KIn(=In@-pN\* _ [1-0.2In(-In(1-0.067))\*>

Cprob = (1—K-ln(—ln(0.98))) _( 1-0.2-In(- 1n(0.98)) ) =0.928
« R reference period > p = 1/R

For terrain category IV, the mean wind velocity vm is calculated using the following formula (4.3) of EN 1991-
1-4:
Vm(2) = ¢r(2) ¢ (2) Vi

e ¢(z) =k, -In (%) for Zyin < 2 < Zyax
(@ = ¢t (Zmin) forz < zyin
* ¢ orography factor: taken as 1.0, unless specified otherwise in EN 1991-1-4 §4.3.3

0.07
k. = 0.19 (—0)

Zo,I1

For our example:
0 0.07

0.07
_ Zo yA _ . 20) _
vp(z) = 0.19 (Zo,n> In <Zo) co(2) - vy, = 0.19 (0'05) In (1.0 1.0-23.21 =16.29 m/s
The peak velocity pressure is calculated with formula (4.8) of EN 1991-1-4:

1
qp(Z) = ce(2) - qp = ce(2) E p 'VIZJ

s 1.25 kg/m?
¢ Ce(Z) = [1 +7- IV(Z)] ' (Cr(Z))z ' (CO(Z))Z
. =— L <z<
1, (2) co(z)-ln(%) for zmin <2 < Zpax
* IV(Z) = IV(Zmin) forz < Zmin
e Kk turbulence factor: value may be given in the National Annex (0.85 for terrain category IV

according to NBN EN 1991-1-4)

For our example the maximal wind pressure  will become:

kl 2 2 1 kl 1
qp(z) =[1+7- | (c:(2)" - (co(2)) -E-p-vf): 1+7 ————~ -E-p-vfn
co(z) " In (%) co(z) - In (z)
5
ap(#) = | 147 ———5o=| -2 125 16.29% = 496 N/m? = 0.496 kKN/m®

EN 12811-1 86.2.7.4.2 prescribes that if the scaffolding is into service, it only needs to be loaded with the so-
called working wind load: a uniformly distributed velocity pressure of 0.20 kN/m2 shall be taken into account.

This working wind load is calculated analogously to the maximal wind load on the scaffolding, but a
reference wind pressure of 0.20 kN/m? is assumed. With ce = 1.64 this leads to gp = 0.294 kN/m2.
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Annex D: Stability analysis

Linear Stability

During a linear stability calculation, the following assumptions are used:
* Physical Linearity.
» The elements are taken as ideally straight and have no imperfections.
» The loads are guided to the mesh nodes, it is thus mandatory to refine the finite element mesh in
order to obtain precise results.
* The loading is static.
» The critical load coefficient is, per mode, the same for the entire structure.
* Between the mesh nodes, the axial forces and moments are taken as constant.

The equilibrium equation can be written as follows:
[Kg —Kgl-u=F

The symbol u depicts the displacements and F is the force matrix.

As specified in the theory of the Timoshenko method, the stiffness K is divided in the elastic stiffness Ke and
the geometrical stiffness K. The geometrical stiffness reflects the effect of axial forces in beams and slabs.

The basic assumption is that the elements of the matrix K¢ are linear functions of the axial forces in the
members. This means that the matrix Ke corresponding to a A" multiple of axial forces in the structure is the
At multiple of the original matrix K.

The aim of the buckling calculation is to find such a multiple A for which the structure loses stability. Such a
state happens when the following equation has a non-zero solution:
[KE—)\-KG]~U=0

In other words, such a value for A should be found for which the determinant of the total stiffness matrix is
equal to zero:
KE - )\ . KG = 0

Similar to the natural vibration analysis, the subspace iteration method is used to solve this eigenmode
problem. As for a dynamic analysis, the result is a series of critical load coefficients A with corresponding
eigenmodes.

To perform a stability calculation, the functionality Stability must be activated.

Project data >

Basic data Functionality Actions Unit 5et  Protection
GENERAL DETAILED
Property modifiers @ 4 Monlinearity
Model modifiers Beam local nenlinearity @

Parametric input
Climatic loads m

Construction stages

Support nenlinearity/basic soil spr 14

Initial imperfections [0

Mobile loads Geometrical nonlinearity @
Dynamics General plasticity
I Stability &I Compression-enly 2D members
I Nonlinearity m Cables
Structural model @ Friction support/Soil spring @
IFC properties Membrane elements
Prestressing I Subseil
Bridge design 4 Steel

Plastic hinge analysis
Fire resistance checks
Steel connections

Scaffolding [0

OK Cancel

The A values can be found under Results > Critical load coefficients
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The number of critical coefficients to be calculated per stability combination can be specified under Setup >
Solver .

Notes:

» The first eigenmode is usually the most important and corresponds to the lowest critical load
coefficient. A possible collapse of the structure usually happens for this first mode.

e The structure becomes unstable for the chosen combination when the loading reaches a value equal
to the current loading multiplied with the critical load factor.

» Acritical load factor smaller than 1 signifies that the structure is unstable for the given loading.

» The eigenmodes (buckling shapes) are dimensionless. Only the relative values of the deformations
are of importance, the absolute values have no meaning.

« ‘Initial Stress’ is the only local nonlinearity taken into account in a linear stability calculation.

The principle of a stability calculation and the meaning of the matrix Kg will be explained with a simple
example. Suppose the next situation:

Rigid Bar

I L
This beam with length L has a pinned support at the left and a flexible spring support at the right with rigidity:
Ke. Two point loads are inputted on the beam: a vertical force R and a compression force N.

Standard analysis says that R and N are independent (in the undeformed configuration) and the stiffness
relationship is:

KE'I‘=R

With r the vertical translation of the right point of the beam.
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But, if the structure is allowed to deform, we can calculate equilibrium in the deformed configuration as
shown below:

R
T.

Summing moments about the pinned end we get:
R-L+N-r=S-L

The equation for the response of the spring is:
KE r= S

Substituting S we get:
R-L+N-r=(Kg-r) L

Dividing by L:

R+N =K
[ T=Ke'r

N
R= (k=)o

This can further be rewritten if we define the geometric stiffness as:

And grouping terms we have:

giving the final form as:
R=(Kg—Kg)r

Or:
[Kg —Kg]-u=F
When the normal force N is multiplied with a factor dcr so that the total rigidity becomes zero:

e N
KE_ CK'L =0

The structure will buckle and become ‘unstable’.

BV —2024/03/01
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Nonlinear Stability

As specified in the assumptions of the previous paragraph: a stability calculation is by default a linear
process. Nonlinearities like friction supports, pressure only supports, ... are not taken into account.

Specifically for this purpose, SCIA Engineer provides the use of a nonlinear stability calculation. This type of
calculation has the following additions to the linear stability calculation:

* local nonlinearities are taken into account;

« 3 order effects are taken into account using the Modified Newton-Raphson algorithm.

Modified Newton-Raphson follows the same principles as the default method but will automatically refine the
number of increments when a critical point is reached and will only update its stiffness matrix every N
iterations. This method can therefore give precise results for post-critical states.

SCIA Engineer will perform a 3rd Order calculation considering local nonlinearities. After this calculation, the
resulting deformed structure is used for a stability calculation. As a result, the critical load factor of the
structure is obtained for the structure including nonlinearities.

To activate the nonlinear stability calculation, the functionalities Stability and Nonlinearity > Geometrical
nonlinearity must be activated.

Project data >

Basic data Functionality Actions Unit 5et  Protection

GENERAL DETAILED
Property modifiers _;; 4 Nonlinearity
Model modifiers Beam local nenlinearity
Parametric input Support nonlinearity/basic soil spr
Climatic loads 6:1 Initial imperfections |
Mobile loads I Geometrical nonlinearity :EE- I
Dynamics General plasticity
Stability [ Compression-enly 2D members
Nonlinearity v Cables
Structural model 3 Friction support/Soil spring [
IFC properties Membrane elements
Prestressing I Subseil
Bridge design 4 Steel
Construction stages Plastic hinge analysis

Fire resistance checks
Steel connections

Scaffolding [

OK Cancel

In addition, support and/or beam local nonlinearities can also be activated.
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The choice of the 3 order theory, the number of increments and the maximal number of iterations can be
specified through Menu bar > Tools > Calculation & Mesh > Solver settings:

nlw v w ow w

B Solver setup

Name

Specify load cases for linear calculation

Specify combinations for nonlinear calculation

Specify global geometrical imperfections for calculation
Specify combinations for linear stability calculation

Specify combinaticns for nenlinear stability calculation

4 Advanced solver settings

General

Effective width of plate ribs
Nonlinearity

Initial stress

Linear stability

SolverSetupl

Nonlinear stability
Type of eigen value solver
MNumber of buckling modes
Initial load factor
Load factor increment
Maximum number of increments
Maximum iterations
Limit of nodal deformation - direction
Limit of nodal translation [m]
Solver precision ratio

Solver robustness ratio

Lamczos

=

0,1
0,1

10

20
U_total
1,000

e

oK

j Cancel g

Since the nonlinear stability calculation automatically implies the Modified Newton-Raphson method for the
solver, this method cannot be chosen here.

Since the Modified Newton-Raphson method also applies the loading using increments, it is important to set

a right amount of increments. This implies that it is advised to choose the Newton-Raphson method so you

have access to the number of increments.
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Buckling shape
.\’Example Stability _Imperfection.esa
In this example, the use of the buckling shape as imperfection according to EC3 is illustrated for a column.

The column has a cross-section of type R048,3X3,2, is fabricated from S 235 and has the following relevant
properties:

+ E=210.000 N/mm2

o fy =235 N/mmz

*  yw1=1,00

e L =2000 mm

* A =453 mm?

 Ily=116000mm*

*  Wpy=6508.8 mm?3

L
gl—— —1,00

2000

Calculation of the buckling shape

First a stability calculation is done using a load of 1 kN. This way, the elastic critical buckling load Ncr is
obtained. In order to obtain precise results, the Number of 1D elements is set to 10. In addition, the Shear
Force Deformation is neglected so the result can be checked by a manual calculation.

The stability calculation gives the following result:

Critical load coefficients

Stability combination : S1
1 |60,11

This can be verified with Euler’s formula using the member length as the buckling length:

m2El T - 210.000 N/mrnz - 116000 mm*
2 (2000 mm)2

Ner = =60105,89 N

74 BV —2024/03/01



The following picture shows the mesh nodes of the column and the corresponding buckling shape:

—1.00

3D displacement

Stability calculation. Buckling shapes are normalized, so that the maximum nodal displacement resp. rotation component of each mode is equal to

1m resp. Irad.

Stability combinations: S1/1 - 60.11

Selection: Al
Location: In nodes avg..System: Global
Resultson 1D member:

Extreme 1D: Section

Name  dx Fibre Case  ux u
[m] [m [mm]

y uz Px Py L3 Utoeat
] [mm]  [mrad] [mradl [mrad] [mm]
00| 0.0 0.0 1000.0 0.0 0.0

B1 0.000 6 [S1/1-
60.11

B1 0.000 T[syi- | -1L.1| 0.0 203 0.0| 1000.0 00| 23.2
60.11

B1 0.200- T[Sy1- | 66| 0.0 -19.7 0.0 9581 00| 187.6
60.11

B1 0.200- T[Sii- | 2068 00| 1.7 0.0 9501 0.0| 207.8
|60.11

B1 0.200+ T[Sy1- | 186.6| 0.0 -19.7 0.0 9501 0.0 187.6
60.11

B1 0.200+ T[Si/i- | 2068 00| 1.7 0.0 9501 0.0| 207.8
60.11

B1 0.400- T[Syi- | 366.7| 0.0 -17.5 0.0 809.0 0.0 367.1
|60.11

B1 0.400- [Sy1- | 38L7| 0.0] 17.5 0.0 809.0 0.0 382.1
60.11

B1 0.400+ T[Syi- | 3%66.7| 0.0 -17.5 0.0 805.0 0.0 3%67.1
|60.11

B1 0.400+ I [Sy1- | 38L7| 00| 17.5 0.0 809.0 0.0 3821
60.11

B1 0.600- T[Syi- | 51L.0| 0.0 -13.4 00| 5878 0.0 5112
60.11

B1 0.600- I [Sy1- | 519.1| 00| 13.4 0.0 s87.8 0.0 519.3
60.11

81 0.600+ T[syi- | 51L.0| 0.0 -13.4 0.0| 587.8 0.0 5112
60.11

B1 0.600+ 1 [sy1- | 519.1| 0.0 13.4 0.0 s87.8 0.0 519.3
60.11

81 0.800- T[syi- | 604.3| 0.0 7.3 0.0 309.0 0.0 604.4
60.11

B1 0.800- I [Si/1- | 6066 00| 7.3 0.0 309.0 0.0 606.7
60.11

B1 0.500+ T[sy1- | 6043| 0.0 7.3 0.0 309.0 0.0 604.4
60.11

81 0.800+ T[Si/i- | 6066 00| 7.3 0.0 309.0 0.0 606.7
|60.11

B1 1.000- T[sy1- | 6%.6| 0.0 0.0 0.0 0.0 0.0 636.6
60.11

81 1.000+ T[syi- | 6%.6| 0.0 00 0.0 0.0 0.0 63%.6
|60.11

B1 1.200- T[sy1- | 6043| 0.0 7.3 0.0 -309.0 0.0 604.4
60.11

81 1.200- T[Si/i- | 6066 00| 7.3 0.0 -309.0 0.0 606.7
60.11

B1 1.200+ T[syi- | 6043| 0.0 7.3 0.0 -309.0 0.0 604.4
60.11

B1 1.200+ I [S1/1- | 6066 00| 7.3 0.0 -309.0 0.0 606.7
60.11

81 1.400- T[syi- | 51L0| 0.0 13.4 0.0 -587.8 0.0 5112
|60.11

B1 1.400- I [SY1- | 519.1| 0.0 -13.4 0.0 -587.8 0.0 519.3
60.11

81 1.400+ T[syi- | 51L.0| 0.0 13.4 0.0| -587.8 0.0 5112
60.11

B1 1.400+ I [Sy1- | 519.1| 0.0 -13.4 0.0 -587.8 0.0 519.3
AN.11

Using for example an Excel worksheet, the buckling shape can be approximated by a 4t grade polynomial.

700

800
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400

300

200

100

N\

/

AN

y = 1,42E-10x* - 5,70E-07x° + 7,55E-05x2 + 9,88E-01x

500

1000

1500

2000

A polynomial has the advantage that the second derivative can easily be calculated:
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= N = 1,42E71% x* —5,70E77 x® + 7,55E75 x? +9,88E7! x

=N"crmax = 1L70E™ x* —3,43E7°x +1,51E™*
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Calculation of e

Ni = fy-A=235N/ 453 mm? = 106455N
Mgy = fy - Wy = 235N/ ;- 6508.8 mm* = 1529568 Nmm

Y= |Nrey  _ [106455N -

"—J R/Ncr_\/ /60110N = 133
a = 0,21 for buckling curve a
X

1

= 0,45
05[1+a(k-02)+(®) ]+ J (05[1+a(R-02)+ (X)Z])Z -

These intermediate results can be verified through SCIA Engineer when performing a steel ULS check on
the column:

Buckling parameters vy zz
Sway type sway _ [non-sway
System length L 2.000 [2.000 m
Buckling factor k 1.00 1.00
Buckling length | 2.000 [2.000 m
Critical Euler load Ne 60.11 [60.11 kN
Slenderness A 124.98 [124.98
Relative slenderness A 1.33 1.33
Limit slenderness Aeo [0.20 0.20
Buckling curve = a
Imperfection a 0.21 0.21
Reduction factor X 0.45 0.45
Buckling resistance Nos: |48.27 [48.27 kN
—2
L_x ()
— Mgy Y1 1529568 Nmm
>e=0-(A-02) — —M-=0,21-(1,33-02) - —————=3,41mm
Nre 1 _ x-(A) 106455 N

The required parameters have now been calculated so in the final step the amplitude of the imperfection can
be determined.

Calculation of 7init

The mid section of the column is decisive = x = 1000
n..at mid section = 636,6

"

Nermax &t mid section = 1,57E03 1/mm2
= Ne  _3a 60110N I
= ninit - eO . EIYT - 9, mm - 210000 N/ . 116000mm4 . 1 57E-3 1/ . 6 =3, mm
Crmaxcp mm?2 i mm?

This value can now be inputted as amplitude of the buckling shape for imperfection.
To illustrate this, the column is loaded by a compression load equal to its buckling resistance.

However, due to the imperfection, an additional moment will occur which will influence the section check.
The buckling resistance can be calculated as follows:

X-A-fy 2 N _
= 045453 mm? 235 N/ = 47,90 KN

Ngq = Npra =

A nonlinear combination is created in which the buckling shape as imperfection is specified:

g fErFE «2 @ A v Yy
NC1 Name NC1
Description
Type Ultimate ¥

4 Contents of com...
LC2 - Load 47,2 kM [-] 1.00

Bow imperfection MNone v
| Global imperfection Buckling shape v
i Stability 51 v

Eigen shape 1

Max deformation [mm] 3.4

New Insert Edit Delete Close
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Using this combination, a nonlinear second order calculation is executed using Timoshenko’s method

The additional moment can be easily calculated as follows:

1
TA790RN 0,80 kNm

1
Mnit = Npa *Nypge - —— = 47,90 kN - 0,00342 m -
1-—FEd 1 — 2LTT XN
60,11 kN

NCI‘
When performing a steel ULS check on the column for the nonlinear combination, this can be verified. The

critical check is performed at 1 m and has the following effects:
wSECTION CHECK::...

The critical checkis on position1.000 m

Internalforces Calculated Unit

Normal force Nec -47.90 kN

Shear force Vyze [0.00 kN
Shear force Vzec«  [0.04 kN
Torsion Tee 0.00 kNm
Bending moment |My=« [0.80 kNm
Bending moment  |M:zs |0.00 kNm

The additional moment thus corresponds to the moment calculated by SCIA Engineer.

As seen in the diagram of EC-EN, Path 3 is followed: the buckling shape serves as a unique global and local
imperfection. This implies that only a section check and Lateral Torsional Buckling need to be checked.
Since LTB is negligible with this small bending moment, only a section check is required:

-1.00

1=

Scaffolding checkfor tubular members

iy According to EN 12811-1:2003 article 10.3.3.2and equation 9
o Normal forceresistance |Nxc [106.45 [kN
b & § Shear resistance Voo [39.13  [kN
\ Bending resistance Moz [1.41 kNm
Unity check N 0.45 -
) Unity check V 0.00 -
E Unity check M 0.57 -
N Unity check Interaction 0.74 -
[l% y Unity check Max 0.74 |-

The member satisfies the section check.

This example has illustrated the use of a buckling shape as imperfection. Depending on the geometry of the
structure, this imperfection can have a large influence on the results due to the additional moments which
occur.

When using this method, it is very important to double check all applied steps: small changes to the loading
or geometry require a re-calculation of the buckling shape and amplitude before a nonlinear analysis may be
carried out.

As a final note: the buckling shape only gives information about a specific zone of the structure. The
imperfection is applied at that zone and results/checks are only significant for that zone. Other combinations
of loads will lead to another buckling shape thus to each load combination a specific buckling shape must be
assigned and a steel code check should only be used on those members on which the imperfection applies.
Since the applied buckling shape corresponds to a global mode, failure of these members will lead to a
collapse of the structure.
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